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Using This Guide

This guide provides information about the configuration and 
operation of Avid® MediaLog™. 

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware that 
are covered in the documentation. 

Who Should Use This Guide
This guide is for video and film editors who wish to log clips before 
bringing them to an Avid editing system for batch digitizing and 
editing. 
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About This Guide
This guide is designed to keep pace with current advances in the Avid 
system’s logging capabilities by consolidating in one comprehensive 
resource all the information you will need to take advantage of the 
many MediaLog options available to you. 

This guide includes basic logging information and has the following 
overall structure:

• Chapter 1, “Understanding MediaLog,” provides an overview of 
MediaLog.

• Chapter 2, “Getting Started,” describes how to set up the 
hardware and run MediaLog sessions.

• Chapter 3, “Working with the Project Window,” describes how to 
structure and view important information in a project.

• Chapter 4, “Logging Source Material,” describes how to use 
MediaLog to log your clips in preparation for digitizing later 
when using Avid editing system products.

• Chapter 5, “Organizing with Bins,” describes how, after creating 
clips, you can rename, subcatalog, sort, sift, select, duplicate, and 
delete them. This chapter also describes how you can analyze the 
clips in a Bin view.

• Chapter 6, “Creating MediaLog Output,” provides information on 
how you can print the bins to create a paper record of your log, 
export the bin files for use in a different application, or transfer the 
bins to an Avid editing system for digitizing and editing the 
footage.

• The appendixes provide reference information such as 
specifications for creating an Avid log file and how to log film 
information.

• Finally, a detailed Index helps you quickly locate specific topics.
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Symbols and Conventions
Unless noted otherwise, the material in this document applies to the 
Windows 2000 and Macintosh operating systems. When the text 
applies to a specific operating system, it is marked as follows:

• (Windows) or (Windows only) means the information applies to 
the Windows 2000 operating system.

• (Macintosh) or (Macintosh only) means the information applies to 
the Macintosh operating system.

The majority of screen shots in this document were captured on a 
Windows 2000 system, but the information applies to both 
Windows 2000 and Macintosh systems. Where differences exist, both 
Windows 2000 and Macintosh screen shots are shown.

The Avid MediaLog documentation uses the following special 
symbols and conventions:

1. Numbered lists, when the order of the items is important.

a. Alphabetical lists, when the order of secondary items is 
important.

• Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

t One arrow indicates a single-step procedure. Multiple arrows in a 
list indicate that you perform one of the actions listed.

The k symbol refers to the Apple or Command key. Press and hold 
the Command key and another key to perform a keyboard shortcut.

In this document, Avid drive refers to the Macintosh system’s internal 
hard drive. Apple Computer, Inc. names the internal hard drive 
Macintosh HD. Depending on your system’s setup, the internal hard 
drive might have a different name.
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Courier Bold font identifies text that you type.

Look here in the margin 
for tips.

In the margin, you will find tips that help you perform tasks more 
easily and efficiently.

n A note provides important related information, reminders, recommendations, 
and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

If You Need Help
If you are having trouble using MediaLog, you should:

1. Retry the action, carefully following the instructions given for that 
task in this guide.

2. Check the documentation that came with your hardware for 
maintenance or hardware-related issues.

3. Check the release notes supplied with your Avid editing system 
for information on accessing the Avid Web site and the Avid 
Knowledge Center.

4. For support services, call Avid Customer Support:

- Broadcast products — call 800-NEWS-DNG (639-7364).

- Postproduction products — call 800-800-AVID (2843).
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Related Information
This guide frequently refers to other Avid manuals for additional 
information. The following table shows the references and the related 
manuals.

n Avid Xpress and Avid NewsCutter systems do not have input and output 
guides. All relevant information is included in the user’s guide for these 
products.

n In this guide, the term Avid system is a generic term that refers to any Avid 
application, including MediaLog. The term Avid editing system refers to one 
of the Avid video editing applications such as Avid Symphony, Avid 
Media Composer, Avid Film Composer, Avid Xpress, or Avid NewsCutter.

Avid Editing System References Related Manual

Avid Symphony™ editing guide Avid Symphony Editing Guide

input and output 
guide

Avid Symphony Input and Output Guide

Avid Media Composer® 
and Avid 
Film Composer®

editing guide Avid Media Composer and Film Composer Editing 
Guide

input and output 
guide

Avid Media Composer and Film Composer Input and 
Output Guide

Avid Xpress® user’s guide Avid Xpress User’s Guide

Avid NewsCutter® user’s guide Avid NewsCutter User’s Guide
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If You Have Documentation Comments
Avid Technology continuously seeks to improve its documentation. 
We value your comments about this guide, the Help, the Online 
Publications CD-ROM, and other Avid-supplied documentation.

Simply e-mail your documentation comments to Avid Technology at 

TechPubs@avid.com

Please include the title of the document, its part number, revision, and 
the specific section you are commenting on in all correspondence. 

How to Order Documentation
To order additional copies of this documentation from within the 
United States, call Avid Telesales at 800-949-AVID (2843). If you are 
placing an order from outside the United States, contact your local 
Avid representative.



CHAPTER 1
Understanding MediaLog

MediaLog is a tool that helps you select and log footage before your 
edit session. Although you can log footage with Avid editing system 
products, using MediaLog can free up your Avid editing system for 
editing rather than for logging footage. After logging shots (for 
example, on a laptop), you can use your Avid editing system to 
digitize and edit the footage. In addition, you can transfer film to 
National Television Standards Committee (NTSC) or Phase 
Alternating Line (PAL) video, use MediaLog to log the material, and 
then transfer the logged shots (also known as clips) to an Avid editing 
system for digitizing and editing.

This chapter answers the following questions:

• What Is MediaLog?

• How Does MediaLog Work?

• What Are the Basic Logging Steps?
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What Is MediaLog?
MediaLog is portable; you can install it on a laptop and on most 
desktop computers that are running the Windows NT®, Macintosh®, 
Windows® 98, Windows 2000, or Windows Me operating system. To 
log shots from a source tape, your computer must be connected to a 
deck that uses Sony® serial deck protocol. MediaLog allows you to 
control the deck while viewing your source tapes and selecting the 
shots for your log. You can also log without a deck and enter the 
logging information by hand.

For each shot that you log, MediaLog saves the start and end 
timecodes, duration, tracks selected, and tape name.

MediaLog also lets you add new categories of information to your log, 
so you can record the scene, take, location, or any other comments that 
can help you to identify the footage.

Once you have created a log, the MediaLog Sort command orders your 
shots according to criteria you specify. The Sift command uses your 
criteria to pick out specific footage, such as all the product shots or all 
shots from a certain location.
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How Does MediaLog Work?
The MediaLog system uses clips, bins, and projects to organize your 
work.

MediaLog clips and bins are a lot like their film counterparts. Just as 
film editors pull clips from their raw footage and store the clips in bins 
for the editing session, MediaLog lets you select shots from your tapes 
and store information about the shots in electronic bins.

A clip corresponds to a shot you select from a tape. Clips contain 
information about your footage such as the start and end timecodes 
and the number of video and audio tracks. Clips are stored in 
electronic bins, which have built-in database capabilities to help you 
easily find a specific shot.

Each time you log clips, you open a bin and use Logging Tool controls 
to play your tapes, mark the shots, and add the clips to the open bin.

A bin is open while you log clips to it.

Deck and log controls are in the Logging tool.

Sample bin
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If you have a log sheet, you can log clips without using a deck. You 
type the start and end timecodes for each clip, and then add them to 
the bin.

MediaLog uses a project file to organize all the work you do on a 
single job. You must always create a new project or open an existing 
project before you can open a bin and log your shots.

As you work on a project, MediaLog remembers the name of each bin 
you open and displays a list of bin names in the Project window. The 
list is useful for helping you to quickly access bins. 

Deck controls Log controls

Bin names

Sample Project 
window
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What Are the Basic Logging Steps?
To perform a logging session:

1. Start your computer and the MediaLog program.

2. Create a new project, or open an existing project.

3. Create a new bin, or open an existing bin.

4. Prepare to log:

a. Select a video format.

b. Enter Logging mode.

c. Select a source name.

5. Select the tracks you want to log from the tape.

6. Log the clips.

7. Save and organize the bin.

8. Quit the MediaLog application, and (optionally) shut down the 
computer.
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CHAPTER 2
Getting Started

This chapter describes how to set up the hardware and run MediaLog 
sessions. 

This chapter covers the following topics:

• Setting Up the Hardware (Windows)

• Setting Up the Hardware (Macintosh)

• Supported Decks

• Turning On the Hardware

• Installing MediaLog (Windows)

• Installing MediaLog (Macintosh)

• Starting MediaLog

• Setting Up Project Files and Folders

• Backing Up Your Project Information

• Ending a Work Session

• Using Help
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Setting Up the Hardware (Windows)
Make sure your computer meets the following requirements:

• The computer must be running the Windows NT, Windows 98, 
Windows 2000, or Windows Me operating system.

• The computer includes at least 32 megabytes (MB) of random 
access memory (RAM).

MediaLog can control a deck that uses Sony serial deck protocol and a 
timecode reader. You can control a single deck by connecting an 
RS-232 to RS-422 serial adapter kit to the serial port of your computer. 
MediaLog can also control a deck through V-LAN® VLXi® 
connections.

n If you need to connect and control more than one video deck, see the setup 
guide for your Avid editing system.

A direct serial video deck connection requires a serial adapter kit that 
contains these items (see the following figure):

• An RS-232 to RS-422 serial adapter

• Two serial cables; male 9-pin connectors at both ends

c The computer and the deck must be off when you are connecting the 
serial cable.

To connect a single deck to your PC:

1. Turn off the computer and the deck.

2. Attach one end of the first 9-pin cable to the end of the serial 
adapter labeled RS-232. 

3. Attach the other end of the first 9-pin cable to the serial port of 
your computer.

n When you attach the cable to the serial port on the computer, note if it is 
port 1 or port 2. You will have to select the port in the Avid software.
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4. Attach one end of the second 9-pin cable to the end of the serial 
adapter labeled RS-422. 

5. Attach the other end of the second 9-pin cable to the remote serial 
port of the deck.

n Set the deck to Remote mode before you attempt to control the deck using the 
software.

For more information about connecting decks, see the setup guide for 
your Avid editing system.

Setting Up the Hardware (Macintosh)
Make sure your computer meets the following requirements:

• The computer must be running the Macintosh operating system 
Version 9.1 (or later).

• At least 12 MB of RAM must be available to run MediaLog (20 MB 
or more is preferred when working with large bins).

MediaLog can control a deck that uses Sony serial deck protocol and a 
timecode reader. You can connect a single deck to your system using 
the serial board located in the G4 system or using a USB-to-serial 
adapter connected directly to the USB hub, and then connecting a 
direct serial cable with a round 8-pin DIN connector at one end and a 
9-pin D connector at the other end.

To your 
computer

To your 
deck

RS-422 connection

Serial adapter

RS-232 connection
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n If you need to connect and control more than one video deck, see the setup 
guide for your Avid editing system.

c The computer and the deck must be off when you are connecting the 
serial cable.

To connect a single deck to your system:

1. Locate a serial cable.

2. Do one of the following:

t Attach the round 8-pin DIN connector to a serial port 
connector on the serial board.

t Attach the USB-to-serial adapter to the USB hub. 

(See the following figure.)

3. Attach the 9-pin D connector to the remote serial connector on the 
back of the deck.

n You might have to place the video deck in Remote mode by turning a switch 
before attempting to control the video deck using the software.

For more information about connecting decks, see the setup guide for 
your Avid editing system.

Serial port

1

2

1 2

USB-to-serial adapter

USB hub
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Supported Decks
For a list of supported decks, search for “Supported Decks” in the 
Avid Customer Support Knowledge Center on www.avid.com. See the 
Avid editing application release notes for instructions on how to 
access the Knowledge Center.

Turning On the Hardware
To be sure that the computer detects all the attached hardware and to 
avoid damage to any component, turn on the hardware in the 
following order:

1. If your computer has media drives, turn on each drive.

Wait 15 to 30 seconds for the drives to spin up before you turn on 
the computer system; otherwise, the computer will not 
communicate with the storage devices successfully.

2. If you will be logging clips using a deck, turn on the deck.

Set the REMOTE/LOCAL switch on the deck to REMOTE.

3. Turn on the computer.

c Do not disconnect or turn off individual drives while the 
computer is on. 

You can now install the MediaLog software. 
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Installing MediaLog (Windows)
MediaLog software is shipped on the MediaLog CD-ROM and the 
Avid editing application CD-ROM. 

n For information on installing MediaLog from the Avid editing application 
CD-ROM, see the release notes for your Avid editing system.

To install MediaLog software on Windows NT, Windows 98, 
Windows 2000, or Windows Me systems:

1. Quit all Windows applications.

2. Insert the MediaLog CD-ROM into your computer’s CD-ROM 
drive. 

If the installer doesn't run automatically after you insert the 
application CD-ROM, do the following:

a. Double-click the My Computer icon.

b. Double-click the CD-ROM icon. 

c. Double-click Launch.exe to run the installer. 

The MediaLog Installer CD-ROM window opens.

3. Click Installers.

4. Click Install Avid MediaLog.

The MediaLog Welcome window opens.

5. Click Next.

The Country Selection for License Agreement window opens.

6. Select the country in which you purchased this product, and then 
click Next.

7. In the License Agreement window, read the agreement, and then 
click Yes to accept the terms of the agreement. 

The Choose Destination Location window opens.
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c Do not install the MediaLog application on disks where you store 
media.

c If you install MediaLog on an Avid editing system, make sure the 
MediaLog application is in a folder separate from the Avid editing 
application. Each application has its own preferences.

8. Click Next to accept the default location or Browse to find a 
different location. 

The Setup Type window opens.

9. Select Typical, and then click Next. 

The installation begins.

When the installation is complete, a message asks if you want to 
restart the system. 

10. Restart the computer now or later (before you start the MediaLog 
application). 

Installing MediaLog (Macintosh)
MediaLog software is shipped on the MediaLog CD-ROM and the 
Avid editing application CD-ROM. 

To install MediaLog software on Macintosh systems:

1. Restart your Macintosh system.

2. Quit any applications that run automatically at startup.

3. Insert the MediaLog CD-ROM into your computer’s CD-ROM 
drive. 

4. Double-click the MediaLog Installer icon.

A splash screen introduces the Installer.

5. Click Continue.
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The MediaLog Installer window opens.

The Install pop-up menu contains the following choices:

- Easy Install

- Uninstall

6. Choose Easy Install.

7. Accept the default installation location from the Install Location 
pop-up menu or choose another location.

If you want to change the installation location:

a. Click the Install Location pop-up menu.

b. Choose a different disk or “Select Folder.”

c. If you choose “Select Folder,” navigate to the folder and click 
Select.

The new installation location appears in the Install window.

Install pop-up menu

Install Location 
pop-up menu
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c Do not install the MediaLog application on disks where you store 
media.

c If you install MediaLog on an Avid editing system, make sure the 
MediaLog application is in a folder separate from the Avid editing 
application. Each application has its own preferences.

8. Click Install.

The Country Selection for License Agreement window opens.

9. Select the country in which you purchased this product, and then 
click OK.

10. In the License Agreement window, read the agreement, and then 
click Yes to accept the terms of the agreement.

When the installation is complete, a message asks if you want to 
quit the installer. 

11. Click Quit.

Starting MediaLog
After you install MediaLog, you are ready to start the application. 

To start MediaLog:

1. Turn on the video deck.

2. Set the REMOTE/LOCAL switch on the deck to REMOTE.

3. Turn on the computer.

c Do not run any other Avid editing application on the computer at 
the same time as the MediaLog application. The two applications 
will conflict with each other.
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4. Do one of the following:

t (Windows) Click the Start button, point to Programs, point to 
Avid, and then select MediaLog.

t (Macintosh) Double-click the MediaLog folder to open it, and 
then double-click the MediaLog application icon to start 
MediaLog.

The Select User and Project dialog box appears.

5. Select an existing user and project, or create new ones, as 
described in “Setting Up Project Files and Folders” on page 35.

MediaLog project folders are stored 
in the Avid Projects folder.

Project folder

User folders
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Setting Up Project Files and Folders
Each time you start the MediaLog application or close your current 
project, the Select User and Project dialog box appears. The first thing 
you do in the dialog box is select an existing user and project or create 
new ones. 

To establish your identity as a user, open a new or existing project, and 
close a project, use the following procedures:

• Identifying a User

• Selecting a Project

• Opening a Project

• Closing a Project

You can also create additional folders to store projects, or you can quit 
the application from the Select User and Project dialog box.

Users scroll list Projects scroll list
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Identifying a User

To identify a user for the project, you can either create and identify a 
new user or select one from a list of existing users. This user name 
represents the user profile, which includes the settings associated with 
that user. New users begin with default user settings. When you 
customize the user settings in MediaLog, these customized settings are 
associated with the user name.

The Avid Users folder is the default location for user profile files. For 
information about the Avid folders, see the editing guide or user’s 
guide for your Avid editing system.

Creating a New User

To create a new user profile:

1. Click New User in the Select User and Project dialog box.

The New User dialog box appears.

2. Type a name for the new user in the text box.

n If you plan to move bins and projects from one platform to another, do not use 
the characters / \ : * ? “ < > | when naming projects, bins, and users. 

3. Click OK.

The Select User and Project dialog box reappears with your user 
name highlighted in the Users scroll list.

c Do not share user settings between MediaLog and your Avid editing 
system.

You are now ready to select a project. See “Selecting a Project” on 
page 39.
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Selecting an Existing User

To select from the list of existing users:

t Click the user name to select it in the Users scroll list on the left 
side of the Select User and Project dialog box. 

The selected user profile appears when you open a project.

Folders containing a collection of users appear in the Users scroll list 
with an asterisk (Windows) or a dot (Macintosh) preceding them. 

For information about the location of the user profile files, see the 
editing guide or user’s guide for your Avid editing system.

To select a user name within a folder:

1. Double-click the folder to open it and display the user names.

2. Click the user name to select it.

To change the location 
of user profiles outside 
the Avid Users folder, 
you must use the 
Windows operating 
system or Macintosh 
desktop.

If the user profile you want is stored on your system outside the Avid 
Users folder (in another folder or on a network, for example), you can 
locate it using the Directory pop-up menu in the Select User and 
Project dialog box.

Directory pop-up menu

User names

Folder
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To search for another user profile folder:

1. In the Select User and Project dialog box, click the Directory 
pop-up menu to display a list of other locations on the system.

2. Choose a drive from the Volumes submenu, if necessary, and 
locate the folder.

3. Double-click a selected folder to open it. Continue to open any 
additional folders until the Users scroll list includes the 
appropriate user name.

4. Click the user name to select it.

You are now ready to select a project. See “Selecting a Project” on 
page 39.

Directory pop-up menu
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Selecting a Project

You can either create and open a new project or open an existing 
project.

Creating a New Project

To create a new project:

1. Click New Project in the Select User and Project dialog box.

The New Project dialog box appears.

2. Type a name for your new project in the text box, and click OK.

n If you plan to move bins and projects from one platform to another, do not use 
the characters / \ : * ? “ < > | when naming projects, bins, and users. 



40

Getting Started

3. Choose a project type from the Format pop-up menu, based on 
your source footage (NTSC or PAL) and your Avid editing system 
model.

n For information on creating a film project, see “Creating a Film Project” on 
page 184.

n For additional information on creating a project, see the editing guide or 
user’s guide for your Avid editing system.

4. (Option) Click Matchback. The Matchback item appears only if 
your Avid editing system includes the Matchback option.

For more information about matchback, see “Using the Matchback 
Option” in the input and output guide or user’s guide for your 
Avid editing system.

5. Click OK.

The system creates the new project files and folders, and then 
returns you to the Select User and Project dialog box. The project 
name is highlighted in the Projects scroll list. You are now ready to 
open the project. See “Opening a Project” on page 43.

Setting Film Preferences

If you are logging 24p or 25p footage for a film project, set film 
preferences in the Film Settings dialog box immediately after you 
create the project. This will provide the system with important 
information about the type of film and audio transfer you used for 
your job. For more information, see Appendix B.
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Selecting an Existing Project

Existing projects appear in the Projects scroll list in the Select User and 
Project dialog box.

For information about the location for the project files, see the editing 
guide or user’s guide for your Avid editing system.

To select an existing project, do one of the following:

t Click an existing project name to highlight it.

t Press the first letter of the project name on the keyboard to 
highlight it. (If there are multiple projects that begin with the same 
letter, the first project in the list that begins with that letter will be 
highlighted.)

Projects scroll list Directory pop-up menu
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To open a project nested in a folder:

1. Double-click the folder name to open it and display the contents in 
the Projects scroll list.

2. Click the project name to select it.

If the project you want is stored on your system outside the Avid 
Projects folder (in another folder or on a network, for example), you 
can locate it using the Directory pop-up menu in the Select User and 
Project dialog box.

To locate a project in another folder:

1. In the Select User and Project dialog box, click the Directory 
pop-up menu and choose a drive from the Volumes submenu.

The Select User and Project dialog box displays all the stored 
folders.

2. Double-click a folder name to open it. Continue to open any 
additional folders until the Projects scroll list includes the project 
folder you want. 

3. Click the project name to select it.

You are now ready to open the project. See “Opening a Project” on 
page 43.

Nesting Projects in Folders

You can create folders in the Select User and Project dialog box for 
storing related projects.

To create a folder:

1. Click New Folder in the Select User and Project dialog box.

The New Folder dialog box appears.
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2. Type a name for the folder in the text box, and click OK.

The folder name appears in the Projects scroll list with an asterisk 
(Windows) or a dot (Macintosh) preceding it.

3. Double-click the folder name to open the folder. 

Any new projects you create are displayed and stored in this folder. 

You can also nest projects using the desktop to move existing projects 
into folders that appear in the Select User and Project dialog box. For 
more information about moving existing projects, see “Transferring 
Projects, User Profiles, and Site Settings” in the input and output guide 
or user’s guide for your Avid editing system.

Opening a Project

After you select the appropriate user and project names in the scroll 
lists of the Select User and Project dialog box, you can open the project 
with the selected user settings.

To open the project, do one of the following:

t Click OK in the Select User and Project dialog box.

t Double-click the highlighted project name in the Projects scroll list.

t Double-click the highlighted user name in the Users scroll list.

n If you press and hold the Alt key (Windows) or the Option key (Macintosh) 
while opening a project, the project opens with all bins closed.

For more information 
about the Project 
window, see Chapter 3.

The Project window opens with the selected user settings loaded.

The title bar of the Project window contains the project name and user 
name you selected in the Select User and Project dialog box.
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Closing a Project

To close the current project and return to the Select User and Project 
dialog box, do one of the following:

t Click the Close button (Windows) or the close box (Macintosh) in 
the Project window.

t With the Project window active, choose Close from the File menu.

The Project window and all open bins close, and the Select User and 
Project dialog box appears.

Project name
User name
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Backing Up Your Project Information
Although MediaLog automatically saves your bins, projects, and 
settings, you should back up these items frequently to avoid losing 
any of your work in case your drive fails. Because the storage 
requirements are minimal, you can back up these files to a variety of 
storage devices, such as:

• Floppy disk or equivalent drive

• Removable storage device

• Network storage device (such as a file server)

For information on backing up a project and restoring information 
from a backup, see the editing guide or user’s guide for your Avid 
editing system.

Ending a Work Session
To end the work session, first you must quit the application, and then 
turn off your equipment in the order described in these sections:

• Quitting the MediaLog Application

• Turning Off Your Equipment (Windows)

• Turning Off Your Equipment (Macintosh)

Quitting the MediaLog Application

There are two ways to quit the MediaLog application, depending 
upon whether you have a project open or you are between projects: 

t If you are working on an open project and want to quit MediaLog 
quickly, choose Exit (Windows) or Quit (Macintosh) from the File 
menu.
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The project closes and the application quits.

t If you are between projects, from the Select User and Project dialog 
box:

a.  Click the Quit button. 

A message box appears, asking if you want to leave the 
application.

b. Click Leave to quit the application. Click Cancel to return to 
the Select User and Project dialog box, and select another 
project.

Turning Off Your Equipment (Windows)

When you finish using your system and want to turn it off completely, 
follow these steps to avoid damaging your system or media storage 
drives. Quit the Avid application before turning off your equipment.

To turn off your equipment:

1. Choose Shut Down from the Start menu. 

The Shut Down Windows dialog box appears.

2. Choose Shut down from the pop-up menu, and click OK.

3. When a message states that you can safely turn off your computer, 
press the computer’s Power button.

4. Turn off your speakers and monitors.

5. Turn off each external drive in the chassis, and then turn off the 
chassis itself.

6. Turn off all other hardware.

c Never remove media drives from your Avid system when it is 
turned on. Shut down the computer and then remove the drives.
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Turning Off Your Equipment (Macintosh)

When you finish using your system and want to turn it off completely, 
follow these steps to avoid damaging your system or media storage 
drives. Quit the Avid application before turning off your equipment.

To turn off your equipment:

1. Choose Shut Down from the Special menu. This turns off your 
Macintosh system. The screens on the Bin and Edit monitors 
become dimmed.

2. Turn off your speakers and monitors.

3. Turn off each external drive in the chassis, and then turn off the 
chassis itself.

4. Turn off all other hardware.

c Never remove media drives from your Avid system when it is 
turned on. Shut down the computer and then remove the drives.

Using Help
You can get help and background information for tasks, windows, 
dialog boxes, and screen objects through your Avid Help system. The 
Help system is HTML based and operates in the Microsoft® Internet 
Explorer Web browser. Avid recommends using Internet Explorer 
Version 5 or later.

To open Help from within the MediaLog application:

t Choose MediaLog Help from the Help menu.

Help opens in Microsoft Internet Explorer.

To learn how to use Help:

t Click the Using Help button in the Help system.
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CHAPTER 3
Working with the Project 
Window

The Project window provides controls for structuring and viewing 
important information about your current project. 

This chapter covers the following topics:

• Exploring the Project Window

• Opening and Closing the Project Window

• Using the Bins Display

• Using the Settings Scroll List

• Using the Info and Usage Displays

• Changing Font and Point Size

• Customizing Your Workspace

• Viewing Keyboard Settings

• Using the Avid Calculator

• Using the Serial Ports Tool

• Using the Console
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n (Windows only) This chapter refers to the installation default directory path 
for the various Avid folders. If you selected a different directory path during 
the installation, you must substitute that path when using this chapter.

Exploring the Project Window
The Project window provides controls (Bins, Info, and Usage) for 
structuring and viewing information about your current project. The 
Project window also provides access to the Settings scroll list for 
altering various User, Project, and Site settings.

You can use the Project window to:

• Create and open bins.

• View and modify settings.

• View information about the format of the project and system 
memory usage.

• View information about the work session usage.

• Add folders to organize project components.
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Opening and Closing the Project Window
The Project window opens automatically when you select a project in 
the Select User and Project dialog box.

To close the Project window and return to the Select User and 
Project dialog box, do one of the following:

t Click the Close button (Windows) or the close box (Macintosh) in 
the Project window.

t With the Project window active, choose Close from the File menu.

The Project window remains open the entire time you are working in a 
project; however, it might be hidden from view by several open bins or 
tools.
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To locate and redisplay the Project window, do one of the following:

t Choose Project from the Tools menu.

t Click in an unobstructed area of the Project window to bring it 
forward.

Using the Bins Display
Bins contain the master clips that are created when you log source 
material. From the Project window, you can view a list of bins 
associated with the project, and open, close, and create bins. You can 
also open bins created for another project.

n MediaLog will not open a bin that contains an effect.

To view a list of bins associated with the project:

t Click the Bins tab in the Project window.

From the Bins list you can examine the number, names, sizes, and 
location of the bins.

Bins tab

Bin icon

Fast Menu button

Bins list
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Displaying Folders of Bins in the Bins List

You can add folders to the Bins list in the Project window to help 
organize your project. You can click bins and drag them into folders, or 
click folders and drag them into other folders. See “Managing Folders 
and Bins” on page 59.

To display the folder’s contents in the Bins list of the Project 
window:

t Click the triangular opener next to a folder icon.

To close the display, click the triangular opener again.

To view a list of only the folder contents and not the folders:

t Choose Flat View from the Fast menu. 

The Trash icon and its contents disappear until Flat View is 
deselected.

n The Trash icon doesn’t appear until you select and delete a bin.

New folders

Trash icon

Fast Menu button
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Creating a Folder in a Project

To create a folder in a project:

1. Click the Bins tab in the Project window.

2. Choose New Folder from the Fast menu.

A new untitled folder appears.

3. Click the untitled folder name in the Bins list and rename it.

Creating a New Bin

To create a new bin from the Project window, do one of the 
following:

t Choose New Bin from the File menu.

t Click the New Bin button in the Project window.

A new (empty) bin opens and is given the name of the project as 
displayed in the title bar of the Project window. The new bin appears 
in the Bins list of the Project window with the default name 
highlighted. A corresponding file is placed in the project folder in the 
Avid Projects folder, and a backup copy is placed in the Attic folder.

You can keep the default name of the bin or rename the bin 
immediately. For more information, see “Renaming a Bin” on page 55.
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Renaming a Bin

Each new bin you create takes the name of the project that appears in 
the title bar of the Project window, and is numbered incrementally.

To change the name of a bin:

1. Click the bin name in the Bins list of the Project window.

2. Type a new name.

Opening and Closing a Bin

To open a bin:

1. Click the Bins tab in the Project window.

2. Double-click the Bin icon next to the bin name.

The bin opens in a separate window. The Bin icon in the Project 
window becomes dimmed, indicating the bin is open.

Project name

Default bin name
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Opening Selected Bins

To open several bins at once from the Project window:

1. Click a Bin icon in the Bins list.

2. Ctrl+click (Windows) or Shift+click (Macintosh) each additional 
bin you want to open.

3. Choose Open Selected Bins from the File menu.

Opening Bins from Other Projects

To open a bin from another project:

1. Choose Open Bin from the File menu.

The Open dialog box appears.

2. Find and select the bin you want.

(Windows only) Bins have the file name extension .avb.

c Never open a bin that is stored on a floppy disk or equivalent 
device; otherwise, the system cannot save your work. Always copy 
the bin to a project folder on the system drive before you open it. For 
more information, see the input and output guide or user’s guide for 
your Avid editing system.

3. Click Open.

The bin appears in the Bins list of the Project window in a folder called 
Other Bins. The name Other Bins appears in italic. You can rename this 
folder. This option is useful when you want to open a bin not currently 
displayed in the Project window.

n The Other Bins folder disappears from the Bins list when you delete all the 
bins in the Other Bins folder. Deleting bins from the Other Bins folder does 
not remove the bins from the drive; only the pointers to the bins are removed.
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Closing a Bin

To close a bin, do one of the following:

t Click the Close button (Windows) or the close box (Macintosh).

t Choose Close Bin from the File menu.

Deleting a Bin or Folder

You can delete bins and folders along with their contents from the Bins 
list in the Project window. Deleted bins and folders are moved to a 
Trash folder in the Bins list until you empty the Trash. If you need a 
deleted bin or folder, you can retrieve it from the Trash. For more 
information, see “Viewing Contents in the Trash” on page 57.

c Only bins and folders appear in the Trash. If you select an item in a 
bin and press Delete, the item is permanently deleted and does not 
appear in the Trash.

To delete a bin or folder from the Project window:

1. Select the bin or folder you want to delete in the Bins list.

2. Press the Delete key.

A Trash icon appears in the Bins list in the Project window. The 
Trash contains the deleted item (bin or folder). The deleted item 
(bin or folder) is stored in the Trash until you empty it.

Viewing Contents in the Trash

If you need to view the contents in the Trash or decide you do not 
want to delete those items in the Trash, you must first move the bins or 
folders from the Trash.
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To view items in the Trash:

1. Click the triangular opener next to the Trash icon in the Bins list to 
list the contents of the Trash.

2. Click the bins or folders you want to keep (or view) and drag them 
from the Trash to the Bins list in the Project window.

3. Double-click the bin or folder to view it.

Emptying the Trash in the Bins List

You can empty the contents of the Trash that is located in the Bins list.

c Emptying the Trash permanently removes the bins or folders from 
the drive.

n If you change the name of the Trash icon, you cannot empty the Trash.

To empty the Trash in the Bins list:

1. Choose Empty Trash from the Fast menu.

A message box appears.

2. Click Empty Trash to delete the bins or folders from the Trash and 
from your system drive.
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Managing Folders and Bins

You can use the Project window to create hierarchies of folders and 
bins that reflect the specific workflow of the current project. This 
structure provides both simplicity and backup security.

Creating a hierarchy allows you to have one set of bins available in the 
Project window during the digitizing and organizing phase, and 
another set of bins available during editing to reduce clutter. For more 
information, see the editing guide or user’s guide for your Avid 
editing system,

Saving Bins Automatically

MediaLog automatically saves changes to your work on a regular 
basis during each session. You can modify the frequency of the 
automatic backups using the Bin settings in the Settings scroll list in 
the Project window.

When you are working with bins, an asterisk (Windows) or a diamond 
(Macintosh) appears before the bin name in the bin’s title bar. The 
asterisk (Windows) or diamond (Macintosh) indicates that the changes 
to the bin have not been saved. Once you save the bin, the asterisk 
(Windows) or diamond (Macintosh) is removed.

When auto-save occurs:

• Any open bins are updated with changes made since the last 
auto-save.

• Copies of these bins are placed in the following folders as backup:

drive:\Program Files\Avid\MediaLog\Attic folder

The system automatically places copies of all bins into the Attic folder 
at regular intervals for backup. The procedure for recovering bin files 
from the Attic folder is described in the editing guide or user’s guide 
for your Avid editing system.
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To adjust the frequency of automatic saves:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Double-click Bin in the Settings scroll list.

The Bin Settings dialog box appears.

3. Type a number in the minutes text box for the Auto-save interval 
option.

4. Click OK.

You can manually save bins for added security — for example, 
immediately after an important edit. When your work is lost, or when 
you want to recover an earlier version of a bin, you can retrieve files 
from the Attic folder.

Saving Bins Manually

You can manually save a specific bin, selected bins, or all bins.

To save a specific bin:

1. Click the bin to activate it.

2. Choose Save Bin from the File menu.

n The Save Bin command appears dimmed if there have been no changes since 
the last time the active bin was saved.

To save all the bins:

1. Click the Project window to activate it but do not select any bins in 
the Bins list.

2. Choose Save All from the File menu.

The system saves all the bins for the project.
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Using the Settings Scroll List
From the Settings scroll list in the Project window, you can view, select, 
open, and alter various User, Project, and Site settings.

To view the Settings scroll list:

t Click the Settings tab in the Project window.

Settings scroll list

Settings type

Settings tab
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Understanding Settings

The three types of settings appear in the Settings scroll list as User, 
Project, and Site.

n For information about the location of the settings files, see the editing guide or 
user’s guide for your Avid editing system.

The function of these settings is as follows:

• User settings are specific to a particular editor. User settings 
reflect individual preferences for adjusting the user interface in the 
MediaLog application. Individual User settings are stored in each 
user folder.

• Project settings are directly related to individual projects. When 
you change a Project setting, it affects all editors working on the 
project. Specific Project settings are stored in each project folder.

• Site settings establish default parameters for all new users and 
projects on a particular system. They can apply to particular 
configurations of equipment installed at the site (for example, 
specification and node settings for an external switcher). They can 
also include other User or Project settings that you copy into the 
Site Settings window. Site settings are stored in a separate Settings 
folder.

Table 3-1 briefly describes each item in the Settings scroll list. The table 
also lists where you can find additional information on a particular 
item, and indicates whether the item has an associated dialog box (or 
window) that you can access from the Settings scroll list.

n For information about navigating in the settings dialog boxes, see the editing 
guide or user’s guide for your Avid editing system.
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Table 3-1 Settings Scroll List

Setting Name Description
For More 
Information

Audio Project Sets the rate for audio input. See the input and 
output guide or user’s 
guide for your Avid 
editing system.

Bin Sets the auto-save interval; 
double-click preferences for bins and 
other bin-related parameters.

See “Bin Settings” on 
page 65.

Deck Configuration Configures channels and decks into 
the system.

See “Configuring 
Decks” on page 80.

Deck Preferences Sets preferences that affect all decks 
configured into the system.

See “Setting Deck 
Preferences” on 
page 90.

Film Sets parameters for edit play rate, ink 
number format, and transfer rate.

See “Film Settings” on 
page 186.

Import Sets parameters for file import. See “Importing Logs” 
on page 110.

Keyboard Maps commands from the Command 
palette to the keyboard.

See “Viewing 
Keyboard Settings” on 
page 73.

Logging Allows you to enable the Pause Deck 
While Logging feature.

See “Pausing a Deck 
While Logging” on 
page 105.

Serial (COM) Ports Configures the serial ports on your 
system for deck control.

See “Using the Serial 
Ports Tool” on page 76.

Workspace Enables you to associate settings and 
windows with a workspace.

See “Customizing 
Your Workspace” on 
page 73.
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Defining Settings

You can use the Settings scroll list to establish a hierarchy of settings 
that address the specific needs of each production phase. 

For example, you can establish:

• User settings for the assistant editor — Facilitate logging, 
digitizing, and organizing projects

• Project settings — Reflect the specific needs of the project

• Bin View settings — Display useful columns of information for 
each bin

c Never use a User settings file that was opened in an Avid editing 
application such as Avid Symphony, Avid Media Composer, Avid 
Film Composer, Avid Xpress, or Avid NewsCutter.

By establishing these settings once, and selecting the appropriate 
setting or bin view in context, you can save time and effort that would 
be spent searching for information or adjusting bin headings 
on-the-fly. You can also save these settings along with your template 
for use on similar projects.

Reviewing Basic Settings

The following are basic system settings to review at the start of your 
project:

• Film Settings

• Bin Settings

• Logging Settings

To view the settings:

t Double-click each setting in the Settings scroll list of the Project 
window.
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Film Settings

Film settings determine essential parameters for accurately capturing, 
tracking, and editing source material for 24p and 25p projects. See 
“Film Settings” on page 186 for a description of film settings.

Bin Settings

The Bin Settings dialog box controls the MediaLog’s automatic save 
features, including the number of backups saved in the Attic folder. 
Table 3-2 describes the Automatic Save and Backup options, and the 
results of double-clicking an object in a bin.

Table 3-2 Bin Settings Dialog Box Options

Option Description

Auto-save interval Specifies the length of time between attempts to auto-save project 
files. The default is 15 minutes.

To avoid interrupting a logging operation, the Avid system waits 
until the system is inactive before auto-saving. Use the “Force 
auto-save at” option to specify an interval at which the system 
will interrupt an operation to auto-save.

Inactivity period Specifies the length of time the Avid system waits while the 
system is inactive before automatically saving the project files. 
The default is 0 seconds.

Force auto-save at Specifies the maximum length of time between auto-saves. When 
the system reaches this time, it will auto-save the project files 
even if it must interrupt an operation to do so. The default is 15 
minutes.
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Logging Settings

These settings define whether the deck will pause during a logging 
operation. See “Pausing a Deck While Logging” on page 105.

Maximum files in attic Specifies the total number of files stored in the Attic folder. When 
a bin is saved, the Avid system copies the previous version of the 
bin to a special folder called the Attic. The default is 30 files.

Keep more files if there are many users working on the system. 
This ensures that all the bins are backed up. 

When there are multiple users working on one system, store Bin 
settings as Site or Project settings. This will ensure that another 
user does not override your settings and delete your backups.

Max versions of any one bin Specifies the total number of single-bin copies stored in the Attic 
folder. This setting prevents filling the Attic with too many 
copies of one bin, at the risk of losing the others. The default is 5 
copies.

Table 3-2 Bin Settings Dialog Box Options (Continued)

Option Description
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Displaying Project Settings

You can display the Settings scroll list of the Project window in 
different groups, depending on what you need to view. Table 3-3 
describes the different settings display groups.

Changing the Settings Scroll List Display

To change the Settings scroll list display of the Project window:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Click the Fast Menu button and choose a settings display group 
from the Settings menu.

The Settings menu displays the selected settings group and the 
Settings scroll list displays only the settings in that group.

Table 3-3 Settings Display Groups

Option Description

Active Settings Displays currently active settings in your Avid system.

All Settings Displays all settings available in the Avid system.

Base Settings Displays Project, User, and Site settings only; no views are displayed.

Bin Views Displays all the Bin View settings you created.

Export Settings Displays all the Export settings.

Import Settings Displays all the Import settings.

Workspaces Displays all the Workspace settings you created.

Workspace Linked Displays only the linked workspaces.
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Working with Settings

You can view and modify most of your current settings by 
double-clicking them in the Settings scroll list of the Project window 
and by selecting new options. You can duplicate, rename, copy, and 
move settings among files or systems.

Selecting Another User

Because User settings are not project or site specific, you can display 
another set of User settings in the Project window.

To select another user:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Choose another name from the User pop-up menu.

The previous user’s settings are saved, and the new user’s settings are 
loaded into the Avid system and the Project window.

User pop-up menu
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Modifying Settings

You can alter the default options for various settings to reflect the 
specific needs of a project or to customize the system based on 
personal preferences. For details, see the editing guide or user’s guide 
for your Avid editing system.

Restoring Default Settings

To restore settings to their default values:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Click a setting to select it. Ctrl+click (Windows) or Shift+click 
(Macintosh) each additional setting you want to select.

3. Choose Restore to Default from the Special menu.

A message box appears, asking whether you want to save the 
settings.

4. Click the Copy & Restore button to copy the current settings 
before restoring the default settings, or click the Restore button to 
discard the current settings.

The system restores the default values for the selected settings.

Using Site Settings

When the system opens a new project, it searches the Site_Settings file 
(located in drive:\Program Files\Avid\MediaLog\Settings folder) and 
loads Site settings and any settings placed in the file. The system then 
loads any Project and User settings not included in the Site_Settings 
file.

Adding settings to the Site_Settings files is useful if you need to 
establish global settings for all new users and projects, such as deck 
settings, a specific start timecode for all clips, or various customized 
features of the interface.
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To load settings into the Site_Settings file:

1. Open a project with the settings you want to establish as Site 
settings. If a project does not already exist with the settings you 
want, create a project and make adjustments to the default settings 
as needed.

2. Choose Site Settings from the Special menu.

The Site_Settings window opens.

3. Click a Project or User setting in the Settings scroll list of the 
Project window, or Ctrl+click (Windows) or Shift+click 
(Macintosh) multiple settings and drag them into the Site_Settings 
window.

Copies appear in the Site_Settings window.

4. Close the Site_Settings window. 

All new users and projects opened from the Select User and Project 
dialog box use these settings as the default settings.
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Using the Info and Usage Displays
The following types of information are also available on the Project 
window:

• The Info display allows you to view basic project information, 
such as the video format (NTSC, for example). The displayed 
information lists the options you selected in the New Project 
dialog box when you created the project. You can also view system 
memory information from the Info display. 

• The Usage display shows information on system usage. You can 
use this information to support business functions such as 
resource management. See the editing guide or user’s guide for 
your Avid editing system for more information.

To open the Info or Usage display:

t Click the Info or Usage tab in the Project window.

The items listed in this view are for information only and cannot be 
changed.

Changing Font and Point Size
You can change the default font and point sizes of the Project and Bin 
windows. You can vary the fonts and point sizes across these 
windows. For example, you can set the Project window to Helvetica, 
13 pt, set one Bin window to Times Roman, 11 pt, and set another Bin 
window to Arial, 12 pt.

Table 3-4 describes the windows you can change, and where these 
changes are saved.



72

Working with the Project Window

To change the font displayed in the Project or Bin window:

1. Click the Project or Bin window to make it active.

2. Choose Set Font from the Edit menu.

The Set Font dialog box appears.

3. Choose a font from the Font pop-up menu. 

n Any font installed on the Avid system appears in the list. For information on 
adding fonts to your system, see your Windows or Macintosh documentation.

4. Type another point size for the font in the Size text box.

5. Click OK. 

The new font and point size appear in the active window.

When you close the window, the last font and point size applied is 
saved with the window.

Table 3-4 Changing Font and Point Sizes

Window Location of Changes

Project Changes the font and point size of the text in the Bins and 
Settings tabs; saved as a Project setting. 

Bin Changes the font and point size of the text in the Bin 
window; saved as a Bin setting (not the Bin View setting).
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Customizing Your Workspace
A workspace is the arrangement and size of tool windows displayed 
on your Avid system. If you are accustomed to working with a 
particular group of windows arranged and sized in a particular setup, 
you can assign them to a workspace setting that you can then recall 
with a Workspace button. For example, during logging you might 
want to display the Logging tool and bins in specific locations.

While in a workspace, you can move tool windows or open and close 
tool windows. The next time you select that workspace, the tool 
windows appear with either:

• The arrangement from the last time you left the workspace

• The arrangement you set for the workspace, regardless of any 
changes you made

For information on setting up workspaces, see the editing guide or 
user’s guide for your Avid editing system.

Viewing Keyboard Settings
Common editing commands are mapped to the MediaLog keyboard. 
Use the Keyboard settings to view the commands mapped to your 
keyboard. You cannot change the mappings in MediaLog.

To view keyboard settings:

t Double-click Keyboard in the Settings scroll list of the Project 
window.

n The Keyboard palette varies, depending on the type of keyboard attached to 
your Avid system. If an Avid-supported European keyboard is attached to 
your Avid system, then the Keyboard palette will match that keyboard.
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The Keyboard settings window opens and displays command buttons 
that are mapped to the keyboard. To view the name of a command 
button, let the mouse pointer rest on the button for a second or two.

Using the Avid Calculator
The Avid Calculator helps you calculate video and film durations, and 
convert timecode and film key numbers to different formats. 

For example, you can:

• Convert drop-frame to non-drop-frame timecode values.

• Convert timecode durations between 30-fps and 25-fps projects.

• Convert a duration in video to the corresponding length in footage 
and frames for measuring 35mm film.

To use the Avid Calculator:

1. Choose Calculator from the Tools menu.

The Avid Calculator opens.
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2. Choose a format from the Format pop-up menu.

3. Make calculations in one of the following ways:

t Click numbers and functions in the Avid Calculator.

t Enter numbers and functions using the numeric keypad.

t Enter numbers and functions using the top row of numbers on 
the keyboard.

You do not need to enter leading zeros, colons, or semicolons for 
timecode.

4. To convert your totals at any time to another format, choose a 
different frame code or key number format from the Format 
pop-up menu.

Format pop-up menu
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Using the Serial Ports Tool
The Serial (COM) Ports tool (Windows) or Serial Ports tool 
(Macintosh) allows you to view the current configuration of the serial 
interface at any time during editing. You can also use it to reconfigure 
the ports without quitting MediaLog or shutting down the computer.

To access the Serial (COM) Ports or Serial Ports tool:

1. Double-click Serial (COM) Ports (Windows) or Serial Ports 
(Macintosh) in the Settings scroll list of the Project window.

The Serial (COM) Ports (Windows) or Serial Ports (Macintosh) tool 
opens.

n If you have not yet configured a deck, the window might be empty.

2. View or change the port for one or more decks. 

You configure the deck and port in the Deck Configuration dialog 
box (see “Configuring Decks” on page 80). You can change the 
port in the Serial (COM) Ports (Windows) or Serial Ports 
(Macintosh) tool, but whenever MediaLog starts it will use the 
port selected in the Deck Configuration dialog box.
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Using the Console
The Console window provides a number of features, including:

• Current system information, including your system ID number

• A log of error messages

c Do not use the programming features of the Console without 
guidance from Avid professionals. Contact your local Avid Reseller 
(in North America, you can contact Avid Customer Support). 

To display current system information:

1. Choose Console from the Tools menu to open the Console 
window.

2. Scroll to the top of the Console window to view your system 
information and ID. This feature is especially useful for finding 
the system ID before you contact your Avid Reseller or Avid 
Customer Support.
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CHAPTER 4
Logging Source Material

You use MediaLog to log your clips in preparation for digitizing later 
when using Avid editing applications.

This chapter covers the following topics:

• Understanding Logging

• Configuring Decks

• Setting Deck Preferences

• Understanding Drop-Frame Timecode and Non-Drop-Frame 
Timecode

• Preparing to Log Material

• Logging

• Logging Film Information

• Modifying Clip Information After Logging

• Creating Avid Logs

• Importing Logs
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Understanding Logging
MediaLog requires that you name the clips that you log, the tapes they 
came from, and their start and end timecodes. Many editors prefer to 
log all their clips (shots) first and then batch digitize their material 
later in the Avid editing application.

The three basic methods for producing a bin or log that can be used 
later for batch digitizing are:

• Logging directly to a bin

• Importing standard log files to a bin

• Creating Avid logs

The MediaLog tools automate the process of recording each clip’s start 
and end timecodes, track selection, and other important data. You do 
not need to enter information manually. However, if a source deck is 
unavailable, or if you have already logged the data on paper, you can 
manually record clip data in a bin.

The logging tools provided in MediaLog are also available in the Avid 
editing system products. Bins that you create with MediaLog are 
completely compatible with your Avid editing system product — you 
can copy MediaLog bins to the Avid editing system to begin working 
with the logged footage.

Configuring Decks
The MediaLog application provides a feature that will automatically 
configure your attached deck. Each time you quit the MediaLog 
application, the deck configuration settings are saved. If you reconnect 
the deck to a different port, or attach a new deck, you must run the 
automatic deck configuration feature again. 
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If MediaLog does not automatically sense your attached deck, you 
must manually configure the deck. 

n MediaLog will not override the configurations that were manually specified.

Automatic Deck Configuration

Use the automatic configuration feature before manually trying to 
configure any attached deck. If the automatic feature does not sense 
your attached deck, see “Manual Deck Configuration” on page 81. 

To automatically sense the attached deck:

t Choose Autoconfigure All Ports from the Special menu.

MediaLog searches the system ports and configures the attached 
decks.

Manual Deck Configuration

MediaLog offers an alternative method of configuring your deck if it 
cannot be automatically configured. You can manually configure 
single or multiple decks even if the decks are not currently attached to 
the system. Stored deck configurations can also be deleted. 

The Deck Configuration and Deck Preferences settings appear as 
separate items in the Settings scroll list of the Project window.
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Deck Configuration settings allow you to establish deck control 
parameters for a single deck or for multiple decks. As with all settings, 
you can create multiple versions, allowing you to select among them 
for frequent changes in hardware configurations.

Deck Configuration settings and global deck control preferences 
appear as separate items in the Settings scroll list of the Project 
window.

For information on setting Deck Preferences, see “Setting Deck 
Preferences” on page 90.

c You must manually configure the appropriate hardware connections 
before Deck Configuration settings can take effect. For more 
information, see the setup guide for your Avid editing system.

To configure a deck or multiple decks:

1. Double-click Deck Configuration in the Settings scroll list of the 
Project window.

The Deck Configuration dialog box appears.

Deck settings
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2. If you are configuring your system for the first time, click the Add 
Channel button to add a new channel box on the left side of the 
Deck Configuration dialog box and to automatically open a 
Channel dialog box.

n Channel refers to the signal path for deck control, whether directly through a 
serial port or through a V-LAN VLXi system connected to a serial port. 
Direct serial port connection allows one deck for each channel, while a V-LAN 
VLXi system provides multiple decks.
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3. Choose one of the following from the Channel Type pop-up menu, 
depending upon your system configuration.

For more information 
on V-LAN equipment, 
contact your Avid sales 
representative.

t Direct if you are controlling a deck through an RS-422 
connection to the serial port. 

t VLAN VLX if you are controlling a deck through a 
V-LAN/VLXi connection.

4. Choose the port to which you are connecting the deck from the 
Port pop-up menu

n If you are not sure which port to choose, check the 9-pin serial port connectors 
on the back of the system. If the ports are not labeled, see the hardware 
documentation supplied with your system.

5. Click OK to close the Channel dialog box.

A message box appears, asking if you want to automatically 
configure the channel now.

6. Click Yes if you want to automatically configure the channel.

A new channel appears in the display area of the Deck 
Configuration dialog box, along with the autoconfigured deck.
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n You can reopen the Channel dialog box to change the options at any time by 
double-clicking the channel box in the Deck Configuration dialog box.

7. If you did not autoconfigure the deck, click the channel box to 
select it.

8. Click the Add Deck button to open the Deck Settings dialog box.

n With a deck already connected to the system, you can click the Auto-configure 
button to bypass the Deck Settings dialog box and automatically configure a 
deck with the default settings. 

Decks appear on the right side.

Channel boxes 
appear on the 
left side.



86

Logging Source Material

9. Select settings based on your deck. For information on Deck 
settings, see “Deck Settings Options” on page 87.

10. Click OK to close the Deck Settings dialog box and return to the 
Deck Configuration dialog box.

n You can reopen the Deck Settings dialog box to change the options at any time 
by double-clicking the deck box in the Deck Configuration dialog box.

11. Repeat steps 2 to 10 for each additional channel or deck you want 
to configure.

12. (Option) Select the “Verify configuration against actual decks” 
option (at the bottom of the Deck Configuration dialog box) if you 
want the system to check the deck configuration against the decks 
physically connected to the system. 

The system checks the deck configuration after you click Apply in 
the Deck Configuration dialog box and when you start MediaLog. 
A message box warns you if the configuration does not match the 
deck.
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13. Type a name in the Configuration name text box to name the deck 
configuration. The new deck configuration appears in the Settings 
scroll list of the Project window.

14. Click Apply to complete the configurations and close the Deck 
Configuration dialog box.

15. If necessary, double-click Deck Preferences in the Settings scroll 
list of the Project window to adjust global deck control options. 
For more information, see “Setting Deck Preferences” on page 90.

Deck Settings Options

To access the Deck Settings dialog box, do one of the following:

t Click the Add Deck button in the Deck Configuration dialog box.

t Choose Adjust Deck from the Deck Selection pop-up menu in the 
deck controller section of the Digitize tool. 

t Double-click the deck name in the Deck Settings dialog box.
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Table 4-1 describes the Deck Settings options.

Table 4-1 Deck Settings Options

Option Suboption Description

Name Type your custom name for the tape deck. The default name 
matches the deck type.

Description Enter notes about the deck.
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Notes Displays configuration information, supplied by Avid, about 
the deck you have selected. Not all decks include this 
information.

Device Choose your manufacturer and model from the menus. These 
decks have been qualified to work with your Avid system.

Address For V-LAN VLXi use only (see your V-LAN VLXi 
documentation). If you are using direct serial port deck control, 
this option is unavailable.

Preroll Specifies how many seconds the tape rolls before a digitize or 
digital cut starts. The default is based on the type of deck.

n The Preroll option has no effect in MediaLog.

FAST CUE Speeds up long searches; if your decks can read timecode in 
Fast Forward or Rewind mode. Otherwise, this option is not 
useful.

Switch to ff/rew 
(seconds)

When this option is selected, the system switches to fast 
forward or rewind if the target timecode is beyond the 
specified number of seconds from your current location on the 
tape. 

By default, the deck switches to fast forward or rewind to reach 
a target timecode that is more than 60 seconds away.

If your deck shuttles very quickly, you can increase this number 
so the system uses fast cue only for long searches.

Switch to Search 
(seconds)

When this option is selected, the system switches out of fast 
forward or rewind when it is within the specified number of 
seconds of the target timecode. By default, the system switches 
to Search mode when it is 25 seconds from the target timecode.

Table 4-1 Deck Settings Options (Continued)

Option Suboption Description
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Deleting Deck Configuration Elements

You can delete deck configuration elements to remove or replace them.

To delete deck configuration elements in the Avid system:

1. Double-click Deck Configuration in the Settings scroll list of the 
Project window. 

The Deck Configuration dialog box appears.

2. Click a channel box, a deck box, or the entire configuration to 
select it.

3. Click the Delete button.

4. Click Apply to complete the changes and close the dialog box.

Setting Deck Preferences
Deck preferences are global settings for basic deck control. These 
settings apply to all decks connected to your system, regardless of 
your deck configuration. You can open the Deck Preferences dialog 
box from the Settings scroll list of the Project window. 
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Table 4-2 describes the Deck Preferences options.

Table 4-2 Deck Preferences Options

Option Description

When the deck contains no 
tape, Log As

You select the timecode format (Drop Frame or Non-drop Frame) for 
logging clips when no tape is in the deck. When a tape is in the deck, the 
system automatically uses the existing timecode format on the tape. See 
“Understanding Drop-Frame Timecode and Non-Drop-Frame Timecode” 
on page 92).

Stop key pauses deck This option defines the function of the Stop key (space bar) on the 
keyboard. Select this option to map the space bar to the Pause button on the 
deck. Deselect this option to map the space bar to the Stop button. 

If the videotape heads are down in “Stop key pauses deck” mode, pressing 
the space bar brings up the heads and pauses the deck.

The Stop button in the Digitize tool and Deck Controller tool always stops 
the decks. (Choose New Deck Controller from the Tools menu to access the 
Deck Controller tool.)

Shuttle holds speed The Shuttle button continues shuttling at a constant speed instead of 
stopping when you release it. 

Stop any paused decks 
when quitting

Any paused decks are stopped when you quit the Avid application. 
Selecting this option saves wear on the deck heads.
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Understanding Drop-Frame Timecode and 
Non-Drop-Frame Timecode

Timecode is an electronic indexing method that denotes hours, 
minutes, seconds, and frames that have elapsed on a videotape. For 
example, a timecode of 01:03:30:10 denotes a frame that is marked at 1 
hour, 3 minutes, 30 seconds, and 10 frames.

NTSC video (the video format used mainly in the United States) uses 
one of two formats: drop-frame timecode and non-drop-frame timecode. 
Drop-frame (DF) timecode is designed to match the NTSC scan rate of 
29.97 frames per second (fps). Two frames of timecode are dropped 
every minute except for the tenth minute. No video frames are 
actually dropped. Drop-frame timecode is indicated by semicolons 
between the digits; for example, 01;00;00;00. 

Non-drop-frame (NDF) timecode tracks NTSC video at a rate of 30 fps 
and is indicated by colons between the digits; for example, 01:00:00:00. 
Non-drop-frame timecode can be easier to work with, but does not 
provide accurate timing for NTSC broadcast.

For example, a typical one-hour show uses 52 minutes of video. If your 
program ends at 01:52:00:00 (non-drop-frame), and it is broadcast at 
29.97 fps, it will last 94 frames too long (approximately 3 seconds). The 
final credits could be cut off.

The following illustration compares the two types of timecode at the 
1-minute mark. No frames are actually dropped.
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PAL video (the video format used in many countries other than the 
United States) uses a scan rate of 25 fps. Timecode is indicated by 
colons. There is no need for drop-frame timecode in PAL video. 

You set the default timecode format for logging clips in the Deck 
Preferences dialog box (see “Setting Deck Preferences” on page 90). 
You can select Drop Frame or Non-drop Frame.

You can change the starting timecode of a clip or, for NTSC projects, 
the type of timecode. See the editing guide or user’s guide for your 
Avid editing system.

Preparing to Log Material
MediaLog provides two special tools for logging source material:

• The Logging tool, which contains:

- Source deck controls

- Marking and logging controls

- Active track controls

- Timecode information

- Deck, bin, and tape name information

01:00:59:28 01:00:59:29 01:01:00:00 01:01:00:01 01:01:00:02

01;00;59;28 01;00;59;29 01;01;00;02 01;01;00;03 01;01;00;04

Non-drop-frame
timecode

Drop-frame
timecode



94

Logging Source Material

- Comment section

- Message area

• The Audio Project settings, which enables you to set the audio rate

Accessing and Setting Up the Logging Tool

Once you have opened or created a bin, use the Logging tool to enter 
the name of the tape you are logging and to access deck and logging 
controls.

Use the Logging tool to plan a naming scheme; to work with source 
tapes; and to select tracks, bins, and sources.

Accessing the Logging Tool

To access the Logging tool, do one of the following:

t Click in a Bin window to activate it, and then choose Go To 
Logging Mode from either the Bin menu or the Fast menu.

t Choose Logging from the Tools menu.

Setting Up the Logging Tool

To select the appropriate source deck, source tape, and active track 
settings for your logged material:

1. Open or create your project and the bin in which you want to store 
your master clips. For information about opening projects and 
bins, see Chapter 2.

2. Choose Go To Logging Mode from the Bin menu.

The Logging tool opens.
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Guidelines for Naming Tapes

Consider the following naming guidelines when you provide a name 
for your tape:

• Devise a naming scheme. Although tapes of similar names are 
easy to sort and view together in a bin, distinguishing among 
them might be difficult when you try to quickly locate a specific 
tape. Name the tapes based on the amount and complexity of your 
source material. 

• Use unique names. The system cannot distinguish between two 
tapes with the same name and between two bins or clips with the 
same name. For example, if two tapes are named 001, you might 
encounter problems correctly associating their clips with the 
correct physical tapes. 

• Use alphanumeric characters (A–Z, 0–9), with no spaces before the 
name. Characters can be uppercase and lowercase. The maximum 
length of a name is 31 characters.

n Although the maximum length of a name is 31 characters, most online houses 
accept tape names of no more than 6 characters.

Channel Selection 
area

Mark IN button

Enable timecode 
button

Triangular opener

Deck controller
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• Select a case convention and maintain it throughout a project. A 
single tape can be listed as several different tapes if you alter the 
case of the letters. For example, if you type a single name as 
SUNSET, Sunset, and sunset on three different occasions, all three 
names appear. This can cause problems when keeping track of 
clips during the logging process.

• Be cautious when changing a tape’s name. After you provide a 
name for a tape source, any change to the tape’s name 
automatically changes that tape name everywhere it occurs. If you 
decide later to change the name of one of the tapes from 001 to 999, 
every reference to tape 001 changes to a reference to tape 999.

Inserting Source Tapes

To insert a source tape in a deck to prepare for logging source 
material with MediaLog:

1. Set the REMOTE/LOCAL switch on the deck to REMOTE.

2. Insert a tape into the deck.

3. Choose Go To Logging Mode from the Bin menu.

The Deck Controller tool appears as part of the Logging tool.

Source tape timecode

Source tape display buttonDeck Name

Single-Frame Backward button

Single-Frame Forward button
Rewind button

Eject button
Stop button

Shuttle button

Fast Forward button

Play button

pop-up menu

Valid timecode indicator

Pause button
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Selecting Active Tracks

The Logging tool captures information about the active tracks. 
MediaLog automatically activates the tracks that were active in the 
previous session. 

To change these settings:

t Click tracks in the Channel Selection area of the Logging tool to 
activate or deactivate them.

Selecting the Target Bin

You select a target bin in which you want to organize your logged 
material.

To select a target bin:

t Click the Bin pop-up menu in the Logging tool and make a 
selection. Only opened bins appear in the Bin pop-up menu. 

To open a bin, do one of the following:

For more information 
on working with bins, 
see the editing guide or 
user’s guide for your 
Avid editing system.

t For a bin created in the current project, double-click the bin in the 
Project window.

t For a bin created in a different project, choose Open Bin from the 
File menu, and then locate and open the bin in the Open dialog 
box (Windows) or Select a Bin dialog box (Macintosh).

t Create a new bin by clicking the New Bin button in the Project 
window.

Selecting the Source Deck

In some cases, your source material might not reside on a video deck. 
You can also select other source devices, such as a digital audiotape 
(DAT). Be sure the source material has readable timecode.
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To select the deck where the source material is found:

1. Click the Deck Name pop-up menu to display the available online 
decks.

2. Choose the name of your source deck from the pop-up menu.

Identifying the Source Tape

To select a source tape:

1. Insert a tape into the deck. 

The Select Tape dialog box appears.

n If a tape is already inserted into the deck, click the Source Tape Display button 
in the Digitize tool.

For information about 
deck preferences, see 
“Setting Deck Prefer-
ences” on page 90.

2. In an NTSC project, play the tape for a few seconds so the system 
can detect the timecode format of the tape (drop-frame or 
non-drop-frame). Otherwise, the system maintains the timecode 
format set in the Deck Preferences dialog box, regardless of the 
format on the tape, and you might receive a message indicating a 
wrong tape.
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n Drop-frame timecode appears in the Timecode indicator with semicolons 
between hours, minutes, seconds, and frames. Non-drop-frame timecode 
appears with colons. For more information, see “Understanding Drop-Frame 
Timecode and Non-Drop-Frame Timecode” on page 92

For information on tape 
naming conventions, 
see “Guidelines for 
Naming Tapes” on 
page 95.

3. Provide the system with a tape name in one of the following ways:

t Select the name of the tape from the list in the Select Tape 
dialog box and click OK.

t Click the New button in the Select Tape dialog box if the tape 
is not in the list. A new tape name line appears in the dialog 
box. Type the new name and click OK.

Setting the Audio Sample Rate

Before you begin logging, you must select an audio sample rate.

To set the audio sample rate:

1. Double-click Audio Project in the Settings scroll list of the Project 
window.

The Audio Project Settings dialog box appears.

2. Choose either 44.1 kHz or 48 kHz from the Sample Rate pop-up 
menu.

3. Close the dialog box.
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If you select Batch Digitize in your Avid editing system, and then 
select the “Use the audio compression rate logged for each clip” 
option, you must digitize at the same rate as the audio rate at which 
you logged the clips.

Logging
The following methods are available for logging:

• Logging from a Source Tape

• Logging On-the-Fly

• Logging with the Deck Offline

Logging from a Source Tape

One method of logging is to use MediaLog tools to control a source 
deck, to select shots from your source tapes, and to record clip data 
directly to a bin.

Make sure you have set up all the required information for logging, as 
described in “Configuring Decks” on page 80 and “Preparing to Log 
Material” on page 93. After you establish your settings and specify 
your bin, deck, and tape, the Logging tool is the only tool you need to 
log from a tape to a bin.

The Logging tool provides flexibility in the way you mark your clips 
for logging, as the following illustration shows.
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Marking and Logging

The basic logging procedure involves marking IN and OUT points. 
You mark IN and OUT points using the Mark buttons or by typing IN 
and OUT timecodes.

The button in the top left corner of the Logging tool changes according 
to the stage of logging you are in. When the button appears as a pencil, 
MediaLog is ready to log the clip.

To log clips directly from a source tape to a bin:

1. Insert your tape into the deck.

The Logging Messages bar displays the message “Mark IN,” 
indicating the system is waiting for you to mark an IN point. The 
Mark IN button is displayed in the top left corner of the Logging 
tool.

Mark IN 
button

Timecode entry 
text boxes

Mark IN button

Mark OUT button
Duration Mark button

Mark Memory button Clear Memory button

Go To Memory button

Go To IN button

Go To OUT button

Clear IN button

Clear OUT button

Logging Messages 
bar

Channel Selection 
area

Clip name and 
Comment heading 

Source tape 
display button

Bin name
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2. Set either an IN point or an OUT point for the clip you want to log, 
using one of the following methods:

t Use the deck controls in the Logging tool to cue your source 
tape to the start or end point, and click the Mark IN or the 
Mark OUT button.

t Click the Mark IN button in the upper left corner of the 
Logging tool or press the F4 key.

t If the footage starts at a known IN point or ends at a known 
OUT point, type the timecode in the text box next to the Mark 
IN or the Mark OUT button, press the Go To IN or the Go To 
OUT button to scan the tape forward to the mark, or press 
Enter (Windows) or Return (Macintosh) to enter the mark.

After you set the mark, the Mark IN button changes to the Mark 
OUT and Log button or the Mark IN and Log button.

n The Mark OUT and Log and Mark IN and Log buttons only appear when the 
Pause Deck While Logging feature is not in effect. If you want to pause the 
deck while you enter a clip name and comments, see “Pausing a Deck While 
Logging” on page 105.

c For NTSC film-to-tape transfer or footage downconverted from 
1080p/24, you must log the correct pulldown phase. See “Setting the 
Pulldown Phase” on page 189 and“Entering Pulldown Information” 
on page 194.

3. To finish logging the clip, do one of the following:

t Set the remaining IN or OUT point on-the-fly using the Mark 
IN or Mark OUT buttons or by pressing the F4 key.

t Click the Mark OUT and Log or Mark IN and Log button.

Mark IN

Mark OUT

Mark IN

Go To IN 

Go To OUT

Mark IN
and Log

Mark OUT
and Log
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t Type a timecode for the clip’s IN point, OUT point, or 
duration in the timecode text boxes next to the corresponding 
icon and press Enter (Windows) or Return (Macintosh) .

The system automatically calculates the appropriate timecode for 
the remaining IN point, OUT point, or duration, and enters the 
clip into the bin. The clip name, which is automatically numbered 
by the system, is highlighted and ready to be changed.

c You must enter two of the three timecode marks (IN point, OUT 
point, or duration) to complete the log entry.

4. Name the clip by typing a new name before clicking any of the 
buttons in the Digitize tool.

n Consider changing the clip name immediately, because it is easy to forget the 
contents of each clip if you are logging many clips. You can, if necessary, 
accept the clip name and proceed with the logging process and change the clip 
names in the bin at a later time.

5. Repeat these steps until you have logged all your clips.

n While viewing the footage, you can continuously update your marks 
on-the-fly by clicking the Mark IN or the Mark OUT button repeatedly before 
entering the second mark. See “Logging On-the-Fly” on page 104.

Adding a Memory Mark

You can add a memory mark to a particular location on a tape. 

Mark Memory button Go To Memory button

Clear Memory button
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To mark the location:

t Click the Mark Memory button. 

To move through the tape to the marked location:

t Click the Go To Memory button.

To clear the memory mark:

t Click the Clear Memory button.

You can add one mark per tape. The memory mark is not stored on the 
tape. When you remove the tape from the deck and insert another tape 
into the decks, the mark is cleared.

Logging On-the-Fly

You can log clips while the tape is playing. This is called logging 
on-the-fly. Logging on-the-fly requires the preparation described in 
the following sections:

• “Selecting the Source Deck” on page 97

• “Identifying the Source Tape” on page 98

• “Setting the Audio Sample Rate” on page 99

You can log on-the-fly whether or not you already know where you 
want to mark the IN and OUT points in your clips.

To log on-the-fly:

1. Insert your tape into the deck.

2. Open the bin where you want to store the clips, or create a new 
bin.

3. Choose Go To Capture Mode from the Bin menu.

4. Select the audio and video tracks you want to log and their tape 
name.
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5. Play the tape.

6. Mark an IN point by pressing the E key or I key.

The timecode appears and the Logging Messages bar displays the 
following message: “Mark OUT and Log.”

7. Mark the OUT point by pressing the R key or O key.

8. Log the clip by pressing the F4 key.

The clip is logged into the bin.

The clip name, which the system selects and numbers, is 
highlighted in the bin and is ready to be changed. The default clip 
name is the bin name plus a number.

9. (Option) Type a new name for the logged clip in the bin, and press 
Enter (Windows) or Return (Macintosh).

10. Repeat these steps until you have logged all your clips.

Pausing a Deck While Logging

If the deck is playing while you log clips, you can direct MediaLog to 
automatically pause the deck after you select an IN point and an OUT 
point. While the deck is paused, you can enter the name and comment 
for the clip you want to log.

To pause the deck while logging:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Double-click the Logging setting and select the Pause Deck While 
Logging option in the Logging Settings dialog box.

3. Start the deck playing.

4. When you reach the point where you want to start the clip, click 
the Mark IN button (or press the F4 key). The Mark IN button 
changes to the Mark OUT button, and the deck continues to play.
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5. When you reach the point where you want to end the clip, click 
the Mark OUT button (or press the F4 key again). The Mark OUT 
button changes to the Log Clip button, and the deck pauses.

6. (Option) Enter a clip name and comment.

7. Click the Log Clip button (or press the F4 key again).

The system logs the clip in a bin, and the deck starts playing again.

Logging with the Deck Offline

You can also log material without controlling a source tape deck. If the 
deck is not connected or not working, or if the tape is not available, 
you can still log material as long as you know the timecodes.

To log without a deck or tape:

1. Click the Settings tab in the Project window.

The Settings scroll list appears.

2. Double-click Deck Preferences.

The Deck Preferences dialog box appears.
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3. For NTSC projects, choose either Non-drop Frame or Drop Frame 
from the pop-up menu. This selects the timecode format for 
logging.

4. Click OK to close the Deck Preferences dialog box.

5. Make sure a bin is selected.

6. Choose Go To Logging Mode from the Bin menu.

The Logging tool opens.

7. Click the Source Tape Display button.

A message box appears, asking if you want to associate a tape 
with the deck.

8. Click Yes to open the Select Tape dialog box.

List of tapes
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9. Do one of the following:

t Double-click the name of the tape.

t Click the New button, type the name of the tape you want to 
log, and then click OK.

t Select the name from the list, and then click OK.

10. In the Channel Selection area in the Logging tool, click the tracks 
you want to log. For example, click V, A1, and A2.

11. Choose the destination bin from the Bin pop-up menu.

12. Type the start timecode in the timecode entry text box for mark IN, 
and press Enter (Windows) or Return (Macintosh).

13. Type the end timecode in the timecode entry text box for mark 
OUT, and press Enter (Windows) or Return (Macintosh).

14. Click the Log Clip button.

15. (Option) Rename the clip that appears in the destination bin.

Logging Film Information
Once you have entered or imported the basic log information into a 
bin, you might want to add film-related log information before 
digitizing. See Appendix B for information.

Modifying Clip Information After Logging
You can change or modify the information logged into the bin. This is 
especially useful if you find that some of the data is incorrect, or if you 
need to update the information based on technical needs such as 
varying timecode formats or film specifications.
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There are two ways to modify clip information prior to digitizing: 

• You can modify the information directly by clicking in a column 
and by entering the new information one field at a time. 

• You can use the Modify command to change selected groups of 
clips all at once. 

For information on modifying the pulldown phase, see “Setting the 
Pulldown Phase” on page 189.

c Modifying tape names and timecodes will affect any key numbers 
entered for the selected clips.

Creating Avid Logs
You can use a text editor to log your source footage manually. An Avid 
log lists video clips you want to capture for editing. You can create the 
logs in Avid format, entering data about your source tapes and clips 
according to Avid specifications. 

You can also modify an incompatible log to make it conform to Avid 
specifications. To prepare an Avid log on any type of computer, use 
any text editor. After you create logs, you can import them directly 
into MediaLog bins.

“Supported Avid Log Formats” on page 170 in Appendix A describes 
the format specifications for an Avid log. “Sample Avid Logs” on 
page 180 in Appendix A includes a sample Avid log.

Make a separate log for each videotape, or log clips from several 
different videotapes into one log. After you manually create an Avid 
log, you can import it into MediaLog as described in “Importing Log 
Files into MediaLog Bins” on page 111.
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Importing Logs

Many logging programs and film-to-tape transfer systems create logs 
you can import into your MediaLog project. You can open some logs 
directly in MediaLog bins; others must be converted to Avid format 
first.

Importing Standard Log Files

If you are transferring film to video for logging in MediaLog, ask the 
transfer house to log the source footage during the film-to-tape 
transfer. You can import some standard film-to-tape logs directly into 
MediaLog bins. Many other film-to-tape logs can be converted to Avid 
format using Avid Log Exchange and then imported into MediaLog. A 
number of video logging systems also produce files you can import 
into a MediaLog bin.

Compatible Logs

Use the Import command, in the File menu, to import these files to a 
MediaLog bin:

• Avid Log Exchange (ALE)

• Log Right (file names that have the .ale file name extension)

• Excalibur (file names that have the .ale file name extension)

• Shot Lister

• Avid logs you create yourself, using a text editor (see “Creating 
Avid Logs” on page 109)

• Logs converted into Avid format using Avid Log Exchange (file 
names that have the .ale file name extension)
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n Avid recommends that you convert any files not created on an Avid system 
into Avid format using Avid Log Exchange.

Use the Avid Log Exchange utility to convert these logs to Avid format 
before importing into a MediaLog bin:

• Log Producer™

• AatonBase (file names that have the .flx file name extension)

• FLEx® (file names that have the .flx file name extension)

• Evertz

For additional information about compatible log formats, see 
“Supported Avid Log Formats” on page 170.

For more information about converting a log to the Avid format, see 
the information on Avid Log Exchange in the input and output guide 
or user’s guide for your Avid editing system.

Importing Log Files into MediaLog Bins

To import log files into a MediaLog bin:

1. Open a bin and click to select it.

2. Choose Import from the File menu.

The Select files to Import dialog box appears. For Windows, 
choose Shot Log Files (*.ale) from the Files of type pop-up menu. 
For Macintosh, Shot is already selected as the file type.
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3. Navigate to the drive and then to the folder that contains the log 
file you want to import.

If the log is on a floppy disk, insert the floppy disk into the floppy 
drive.

4. (Option) If you want to adjust import parameters for the shot log, 
click the Options button.

The Import Settings dialog box appears. 

5. Select one of the options from Table 4-3 and click OK.
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Table 4-3 Import Settings Options

Option Description

Maintain events as logged. Select this option to maintain all events as 
originally logged.

Combine events based on scene and automatically 
create subclips.

Select this option to combine all the events for a 
scene into a single master clip, and then link the 
master clip to subclips that represent the original 
events for that scene. To use this option, you must 
have scene numbers logged into a scene column in 
the bin.

Combine events based on camera roll and 
automatically create subclips.

Select this option to combine all the events from a 
camera roll into a single master clip, and then link 
the master clip to subclips that represent the 
original events for that camera roll. To use this 
option, you must have camera roll numbers 
logged into a camera roll column in the bin for a 
film project.

Merge events with known sources and 
automatically create subclips.

Select this option to create subclips for events that 
are merged or relinked to their source clips upon 
import. Use this option if you have already 
entered master clips in a bin for each camera roll 
or master scene, and have subsequently logged all 
the events related to those clips for import.

n You must select the clips that you want to merge 
before selecting this option.

Merge events with known master clips. Select this option to merge information in the shot 
log onto selected master clips based on the 
matching tape name. Use this option if you have 
already logged (or digitized) master clips in a bin 
for each take. 

n You must select the clips that you want to merge 
before selecting this option.
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6. Select files or deselect files from the source file list by doing one of 
the following:

t To add a single file, Ctrl+click the file to import from the 
source file list (Windows) or select a file name in the source file 
list and click Add, or double-click the file name (Macintosh).

t (Macintosh only) To add all files in the source file list, click 
Add All.

t (Windows only) To add a group of files, click the first file in a 
group, and then Shift+click the last file in a group.

t To deselect a single file from the file browser section 
(Windows) or import section, Ctrl+click a highlighted file 
name (Windows) or select a file name and click Remove 
(Macintosh).

7. Click Open (Windows) or Done (Macintosh) to import the selected 
logs to the bin, or click Cancel to cancel the operation.

The bin fills with master clips derived from the information in the 
imported shot log. Any additional information logged with each 
clip is also imported.

8. To save the new master clips that came from importing the log, 
save the bin.
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Transferring Bins from Another MediaLog System

MediaLog bins are interchangeable with those of other releases. In 
general, later releases of the MediaLog application accept bins from 
earlier releases. 

To transfer a bin from one MediaLog system to another MediaLog 
system:

1. Save MediaLog project bins from the first MediaLog system on a 
floppy disk.

2. Go to your second MediaLog system, and quit or minimize the 
MediaLog application.

3. Double-click the Avid Projects folder in the Select User and Project 
dialog box. Double-click the project folder where you want to 
store MediaLog bins.

4. Insert the transfer floppy disk into the floppy drive on the second 
MediaLog system.

5. Navigate to the floppy drive. 

6. Position the floppy drive window and your MediaLog project 
folder window so you can see both.

7. Select (click) the MediaLog bins in the floppy drive window, and 
drag them to your MediaLog project folder.

8. When you start your MediaLog program, open the imported bins 
in the same way you open standard MediaLog bins.
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CHAPTER 5
Organizing with Bins

The Avid system provides powerful database tools for organizing and 
managing your digitized material. You can view bins in two different 
display views. You can rename, print, sort, sift, duplicate, and delete 
clips.

This chapter covers the following topics:

• Preparing to Work with Bins

• Understanding Bin Display Views

• Basic Bin Procedures

• Using Text View
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Preparing to Work with Bins
There are several procedures you might want to perform before 
organizing your project because they affect the display of information 
in bins or the way the clips play back during screening:

• When working with film projects, organize digitized clips 
according to scene. This practice keeps crowded bins to a 
minimum. See “Film Scene Workflow” on page 118.

• If you want to customize the types of objects displayed in a bin, 
see “Setting the Bin Display” on page 119.

• If you need to group or multigroup material, see the editing guide 
or user’s guide for your Avid editing system.

n MediaLog cannot open bins whose sequences contain either effects or 
individual effect clips.

Film Scene Workflow

During the organizing phase, common practice on film productions is 
to organize the digitized clips according to scene. This helps to 
simplify the work environment for the editor, and keeps crowded bins 
to a minimum.

Use the various procedures described in this chapter to organize scene 
bins according to the following basic workflow:

1. Create one bin for each scene using the procedures described in 
“Creating a New Bin” on page 54.

2. Gather clips according to scene using one of the following optional 
procedures:

t Copy clips for each scene from the digitize bins into the 
appropriate scene bin, using procedures described in 
“Copying Clips” on page 128.
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t Duplicate the clips and then move the duplicates into the 
appropriate scene bin, using procedures described in 
“Duplicating Clips” on page 127.

3. Proceed to sort, sift, and organize the clips within each scene bin, 
according to the editor’s preferences.

It is good practice to copy or duplicate clips as you reorganize them in 
bins. As a result, the original source clips will remain in the 
appropriate dailies bin if you ever need to redigitize according to 
source tape.

Setting the Bin Display

By default, your bins display all existing media objects except source 
clips. To reduce crowding in the bin and to display only those objects 
that you need to organize your project, you can display selected media 
objects.

You can use the Set Bin Display option to display clips referenced by a 
sequence, even if the clips were not previously in the bin. Place a 
sequence in a new bin and follow this procedure.

To set the bin display:

1. Click a bin.

2. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.
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Table 5-1 describes the object icons listed in the Set Bin Display 
dialog box.

3. Select the object types that you want to see: usually master clips 
and subclips.

4. The option “Show clips created by user” is selected by default. 
Deselect this option only if you want to hide all objects except 
those created by the system.

5. Select the option “Show reference clips” to automatically display 
objects that are referenced by sequences in the bin, whether those 
clips were previously in the bin or not.

6. Click OK. 

The bin displays objects according to your specifications.
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Table 5-1 shows the available options.

n Effect objects will not display in MediaLog. MediaLog cannot open bins 
whose sequences contain either effects or individual effect clips.

Table 5-1 Object Icon Descriptions

Object Icon Object Description

Master Clips Clips that reference audio and video media files formed from digitized 
footage or imported files

Sub Clips Clips that reference selected portions of master clips

Sequences Clips that represent edited programs, partial or complete, that you created 
from other clips

Sources Clips that reference the original videotape source footage for master clips

Effects Clips that reference unrendered effects that you created.

Motion Effects Files in the bin that reference effect media files generated when you create 
motion effects

Rendered Effects Clips that reference effect media files generated when you render an effect

Groups (For MultiCamera editing) Clips containing two or more grouped clips, 
strung together sequentially according to common timecodes
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Understanding Bin Display Views
There are two display views for viewing and working with clips in a 
bin: Brief view and Text view. This section briefly describes each view.

n You can resize each display view by clicking and dragging the lower right 
corner of the Bin window. The size of the display view is saved as a user 
setting for that bin. The bin view retains its set size every time you open that 
view of that bin, even in separate editing sessions. Each bin view can have a 
different size.

Brief View

In Brief view, the system displays five standard columns of information 
about the clips. You cannot customize the column headings in Brief 
view. This view helps you manage your screen real estate.

To enter Brief view:

t Click the Brief tab in the bin.

n A different set of column headings appears for film projects.
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Text View

For information on Text 
view features, see 
“Using Text View” on 
page 139.

In Text view, clips are displayed in a database text format, using 
columns and rows, with icons representing the various objects. You 
can save various arrangements of columns, text, and objects as 
customized views. See “Customizing Bin Views in Text View” on 
page 124. 

To enter Text view:

t Click the Text tab in the bin.

Bin Views

To the right of the Fast Menu button is the Bin View pop-up menu 
(Text view only) for selecting different bin views. Bins have three 
default views that are automatically installed:

For more information 
on film and statistical 
column headings, see 
“Bin Column Head-
ings” on page 158.

• Custom view: Allows you to create and save customized views. 
The only required column heading is the Name heading, which is 
displayed by default. You can customize the view by adding, 
hiding, or rearranging column headings.

Bin Fast Menu 
button

Text tab

Column 
headings

Object icon

Bin View pop-up menu
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• Film view: Has film-related column headings, including key 
number, ink number, pullin, and so on. If you are working on a 
non-film-related project and select the Film view, a dialog box 
informs you that only the non-film-related columns will be 
displayed.

• Statistics view: Uses the standard statistical column headings 
derived from information established during capture, such as start 
and end timecodes, duration, resolution, and so on.

If you import a log file from your telecine transfer, most of this 
information will be placed in the bin when you import the log. If you 
do not have a film log, then you can enter this information manually 
by highlighting the field in the bin and typing the information.

Customizing Bin Views in Text View

You can create and save customized bin views that you can easily 
access from the Bin View pop-up menu. You can customize the bin 
view by resizing the Bin window and adding, hiding, or rearranging 
bin columns. The only required column heading is Name, which is 
displayed by default.

There are several ways to customize views of the bin:

• Alter the arrangement of existing columns in the standard 
Statistics view or Film view to suit your needs, without adding or 
hiding columns. These arrangements will be recalled each time 
you choose Statistics view or Film view.

• Add or hide columns of information to create customized 
Statistics or Film views. They will be saved as additional view 
settings in numerical order: for example, Statistics.1, Statistics.2, 
and so on, unless you choose another name.

• Add, hide, copy, or rearrange standard or customized columns in 
any combination to create your own custom views. You can name 
and save these views to suit your needs.
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When you create a new bin view, the system saves the settings for this 
view so that you can later access and alter, copy, or delete these 
settings. New bin view settings appear in the Settings scroll list of the 
Project window.

Saving a Custom Bin View

Any time you add, hide, or delete a column, the bin view name 
changes to an italicized name with the file name extension .n to 
indicate that it no longer matches the original view. If you select a new 
bin view setting while the current setting is untitled or italicized, the 
system discards the current setting.

n If you do not save the view after adding or deleting headings, it is discarded.

To save a bin view:

1. Open a bin and click the Text tab.

For procedures on add-
ing, hiding, and delet-
ing bin columns, see 
“Arranging Bin Col-
umns” on page 139.

2. Add or hide columns according to preference. The bin view name 
becomes italicized.

3. Choose Save As from the Bin View pop-up menu.

The View Name dialog box appears.

4. Type a name for the custom view, and click OK.
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Bin Fast Menu

All Bin menu commands are also available in the Bin Fast menu 
located in the lower left corner of every bin. The Bin Fast menu is 
especially convenient when you are working with several open bins 
and need to access Bin menu commands quickly.

To open the Bin Fast menu:

t Click the Fast Menu button in either bin display view.

Basic Bin Procedures
There are some basic procedures that you can use in either bin display 
view for manipulating clips in the bin. They include selecting, 
deleting, duplicating, moving, copying, and sifting clips.

You can also change the font and point size of the text in a bin. See 
“Changing Font and Point Size” on page 71.

When you are working with bins, an asterisk (Windows) or a diamond 
(Macintosh) appears before the bin name in the bin’s title bar. The 
asterisk (Windows) or diamond (Macintosh) indicates that the changes 
to the bin have not been saved. Once you save the bin, the asterisk 
(Windows) or diamond (Macintosh) is removed.

n To view a complete list of the bins in your project, see “Using the Bins 
Display” on page 52.
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Selecting Clips

To select a clip in a bin: 

t Click the clip icon.

To select multiple clips in a bin, do one of the following:

t (Windows) Ctrl+click additional items.

t (Windows) Shift+click the first and last items.

t (Macintosh) Shift+click additional items.

t Lasso several clips.

To reverse your selection:

t Choose Reverse Selection from the Bin menu. 

The items that you previously selected are deselected, and those items 
that were previously deselected are selected.

Duplicating Clips

When you duplicate a clip, the system creates a separate clip linked to 
the same media files. You can move, rename, and manipulate this clip 
without affecting the original clip. 

To duplicate clips:

1. Select the clip that you want to duplicate, or select multiple clips.

2. Choose Duplicate from the Edit menu.

A copy of the clip appears in the bin, with the original clip name 
followed by the file name extension .Copy.n, where n is the 
number of duplicates created from the original clip.
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Moving Clips

You can move clips to other bins in order to group and organize 
various types of material based on project needs.

To move clips from one bin into another:

1. Create or open another bin. Give the bin a name that represents its 
purpose or contents.

2. Position or resize the bins so you can see both of them at the same 
time.

3. Select the clip that you want to move, or select multiple clips.

4. Click the clips and drag them to the new bin.

n If the destination bin’s display has been set to show reference clips, the 
referenced object types do not appear until you save the bin. For more 
information on setting the bin display, see “Setting the Bin Display” on 
page 119.

Copying Clips

When you copy clips, you are essentially cloning the same clip in 
another bin. Any change you make to the copy will affect the original 
as well. The system does not add the .Copy.n file name extension to the 
clip as it does when duplicating. You cannot copy clips to the same 
bin, and you cannot return a clip copy to the same bin where the 
original resides.

When you copy clips from one bin to another, the custom columns that 
you created in the first bin are also copied to the second bin. The 
custom columns appear in the order in which you created them.
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To copy clips from one bin to another bin:

1. Position or resize the bins so that you can see both of them at the 
same time.

2. In the original bin, click the clip that you want to copy, or select 
multiple clips.

3. While pressing the Alt key (Windows) or Option key (Macintosh), 
drag the clips to the destination bin, and release the mouse button.

The copies appear in the destination bin and the originals remain in 
the source bin. If the destination bin’s display has been set to show 
reference clips, the referenced object types do not appear until you 
have saved the bin.

Deleting Clips and Subclips

To delete clips and subclips from a bin:

1. Select the clips and subclips you want to delete.

2. Choose Delete from the Edit menu, or press the Delete key.

The Delete dialog box appears, showing information about the 
selected items (for example, one master clip).

To protect you from accidentally deleting important information, 
the master clips, by default, are not marked for deletion.

3. To mark a master clip for deletion, select the check box next to the 
item. To exempt the master clip from deletion, select the check box 
again.

4. Click OK
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Assigning Colors to Bin Objects

You can assign colors to clips and subclips to help you manage and 
organize the bin objects. Colors assigned to bin objects are referred to 
as source colors. 

Adding a Color Column to a Bin

To add a Color column to a bin:

1. With a bin in Text view, choose Headings from the Bin menu. 

The Bin Column Selection dialog box appears.

2. Ctrl+click (Windows) or click (Macintosh) Color from the scroll list 
to select it.

3. Click OK.

The Color column appears in the bin.

n By default, a new column appears as the last column in the bin. To move the 
Color column, click the Color column heading and drag it to the left.

Assigning a Source Color

To assign a color to a clip or subclip in a bin:

1. With a bin in Text view, select the bin objects that you want to 
assign a color to.

2. Choose Set Clip Color from the Edit menu, and choose a color 
from the submenu.

The color appears in the Color column and on the clip icon.

n You can also assign a color by clicking in the Color column and choosing a 
color from the pop-up menu.
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Assigning a Custom Source Color

To assign a custom color to a clip or subclip in a bin:

1. With a bin in Text view, select the bin objects that you want to 
assign a color to.

2. Choose Set Clip Color from the Edit menu, and choose Pick from 
the submenu.

The Windows Color dialog box or the Macintosh Color Picker 
appears.

3. Select a color from the Windows Color dialog box or the 
Macintosh Color Picker, and click OK.

The custom color appears in the Color column and on the clip 
icon.

n After you assign a custom color, the color appears as Other in the Set Clip 
Color submenu.

Limiting Color Choices

When assigning colors to bin objects, you can limit the color choices to 
only the colors currently used in the bin.

To limit the colors available when assigning colors to bin objects:

1. With a bin in Text view, select the bin objects that you want to 
assign a color to.

2. Alt+click (Windows) or Option+click (Macintosh) in the Color 
column in the bin.

A menu of all the colors you are using in the bin appears. Any 
custom colors you assigned are labeled Other.

3. Choose one of the colors.

The color appears in the Color column and on the clip icon.
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Sifting Clips

When you sift clips, the bin displays only those clips that meet a 
specific set of criteria. For example, you can do a custom sift to display 
only those clips containing the word “close-up” in the heading 
column. The Custom Sift dialog box provides six levels of criteria.

To sift clips:

1. Choose Custom Sift from the Bin menu.

The Custom Sift dialog box appears.

Criterion pop-up menu Text to Find text box
Column or Range to 
Search pop-up menu
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2. Click the Criterion pop-up menu and choose one of the sifting 
options.

3. Click the first Text to Find text box, and type the text that you want 
to use as a sift criterion. When sifting by color, type the exact name 
of the color (using uppercase and lowercase letters) in the text box.

4. Click the Column or Range to Search pop-up menu, and choose a 
column heading to which you want to apply the criterion.

5. Type additional sift criteria, and make additional column 
selections as necessary.

6. Click OK.

Only the clips that meet your criteria remain in the bin, with the 
word “sifted” added to the bin name.

After you have sifted the clips in a bin, you can display the bin in a 
sifted or an unsifted state.

To view the entire bin:

t Choose Show Unsifted from the Bin menu.

To view the sifted bin:

t Choose Show Sifted from the Bin menu.

The word “sifted” appears in parentheses after the bin name when 
you view the bin in its sifted state.

Sifting Timecodes or Keycode Ranges

You can sift on a timecode (or keycode) number within a specific 
range. For example, you can sift for all the clips that start before and 
end after a particular timecode.
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Type 01:08:32:00 in the Text to Find text box in the Custom Sift 
dialog box, and choose Start to End Range from the Column or Range 
to Search pop-up menu.

Some column pairs explicitly define a range; for example, Start and 
End or Mark IN and Mark OUT. Other columns define the beginning 
of a range, and the end of the range is determined by the Duration 
column. For example, Auxiliary TC1 implies a range that begins at the 
value in the Auxiliary TC1 column, and ends at that value plus the 
value in the Duration column.

Before custom sift

After custom sift

The clips that 
encompass the 
timecode number 
01:08:32:00
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If you display any column in the bin that is associated with ranges, 
either explicit or implicit, the corresponding range menu item appears 
in the Column or Range to Search pop-up menu of the Custom Sift 
dialog box. For example, if you choose to display the Start column and 
the Auxiliary TC1 column in the bin, the Start to End Range and 
Auxiliary TC1 Range menu choices will appear in the Column or 
Range to Search pop-up menu.

When specifying a timecode or keycode number, you do not need to 
enter colons or semicolons, and the leading zero may be omitted. For 
example, you can enter 3172000 as a timecode number.

Keycodes contain letters, numbers, and a dash before the feet and 
frames; for example, KJ23 -0345+13. When sifting on a keycode 
number, you only have to enter the numbers after the dash (the actual 
counter portion). Any information before the dash is ignored. If you 
do enter characters before the dash, they must match the 
corresponding characters in the bin column exactly.

Table 5-2 lists all columns associated with explicit ranges and their 
corresponding menu choices: 

Table 5-2 Range Menu Items for Explicit Ranges

Bin Column (Explicit Ranges)
Column or Range to Search 
Pop-up Menu Item

Start, End Start to End Range

Mark In, Mark Out Mark In to Out Range

KN Start, KN End KN Start to End Range

KN Mark In, KN Mark Out KN Mark In to Out Range
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Table 5-3 lists all columns associated with implicit ranges and their 
corresponding menu choices.

Table 5-3 Range Menu Items for Implicit Ranges

Bin Column (Implicit Ranges)
Column or Range to Search 
Pop-up Menu Item

Duration Determines the end of an implicit 
range

Film TC Film TC Range

Sound TC Sound TC Range

Auxiliary TC1 Auxiliary TC1 Range

Auxiliary TC2 Auxiliary TC2 Range

Auxiliary TC3 Auxiliary TC3 Range

Auxiliary TC4 Auxiliary TC4 Range

Auxiliary TC5 Auxiliary TC5 Range

Ink Number Ink Number Range

Auxiliary Ink Auxiliary Ink Range
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Sifting Within a Range

To sift for a timecode or keycode number within a specific range:

1. Choose Custom Sift from the Bin menu.

The Custom Sift dialog box appears.

2. Type the timecode (or keycode) number for which you want to sift 
in a range.

3. Choose a range from the Column or Range to Search pop-up 
menu; for example, Start to End Range or Mark In to Out Range.

The criterion “contain” is displayed in the Criterion pop-up menu. 
If you try to change this criterion, a blank will be displayed in the 
Column or Range to Search pop-up menu.

Column or Range to Search pop-up menuCriterion pop-up menu
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4. Click OK.

The bin will display those clips that encompass the timecode (or 
keycode) number that you entered.

Locking and Unlocking Items in a Bin

You can lock items in a bin to prevent deletion. When you lock clips in 
a bin, you lock their associated media files on your desktop as well.

To lock items:

1. Click a clip or subclip to select it. Ctrl+click (Windows) or 
Shift+click (Macintosh) additional clips, if necessary.

For more information 
on displaying columns, 
see “Showing and Hid-
ing Columns” on 
page 140.

2. Perform one of the following tasks:

t (Windows) Press and hold the right mouse button and choose 
Lock Bin Selection from the Shortcut menu.

t (Macintosh) Press and hold Ctrl+Shift, click the mouse button, 
and choose Lock Bin Selection from the Shortcut menu.

A Lock icon appears for each locked clip in the Lock column of the 
bin in Text view.

Lock icon
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To unlock previously locked items:

1. Select the items in the bin.

2. Perform one of the following tasks:

t (Windows) Press and hold the right mouse button and choose 
Unlock Bin Selection from the Shortcut menu.

t (Macintosh) Press and hold Ctrl+Shift, click the mouse button, 
and choose Unlock Bin Selection from the Shortcut menu.

Using Text View
Text view provides the most complete view of clip information. It uses 
database columns you can rearrange and customize to suit your needs. 
For information about saving a custom bin view, see “Saving a Custom 
Bin View” on page 125.

To enter Text view:

t Click the Text tab in the bin.

Arranging Bin Columns

This section provides procedures for moving, aligning, showing and 
hiding, deleting, duplicating, adding, and changing columns in a bin.
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Moving and Rearranging Columns

To move a text column in a bin:

1. Click the heading of the column you want to move.

The entire column is selected.

2. Click the column and drag it to the position you want, and release 
the mouse button.

The column appears in the new position, and columns to the right 
are moved to make room.

Aligning Bin Columns

When you align bin columns, the system maintains the same order of 
columns from left to right, but spaces them according to the length of 
contents. This is especially useful for removing spaces left after 
moving or rearranging columns.

To align bin columns:

t Choose Align to Grid from the Bin menu.

Showing and Hiding Columns

You can select individual or multiple headings to be displayed or 
hidden in the bin. For a complete description of each column heading, 
see Table 5-8.

To choose column headings:

1. With a bin in Text view, choose Headings from the Bin menu. 

The Bin Column Selection dialog box appears.
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2. Select the headings you want to add to the bin:

t Click the name of a heading to select it.

t Click a selected heading to deselect it.

t Click All/None to select or deselect all the headings.

3. Click OK. 

Only the headings selected in the Bin Column Selection dialog box 
appear in the bin or bin view.
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Deleting a Column

Deleting a statistical column is the same as hiding the column; you can 
restore the column at any time using the Bin Column Selection dialog 
box, as described in “Showing and Hiding Columns” on page 140. 
When you delete a custom column, however, you must re-create the 
column.

To delete a column:

1. Click the column heading in a bin.

2. Choose Delete from the Edit menu or press the Delete key.

The column disappears from the view, and surrounding columns 
fill the empty space.

Duplicating a Column

You can duplicate existing columns containing timecode information 
into other compatible columns that you target in a dialog box.

To duplicate a timecode column:

1. Select the column you want to duplicate by clicking its heading. 

2. Choose Duplicate from the Edit menu.
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The Select dialog box appears.

In the example, “Copy ‘Start’ column to:” appears at the top of the 
dialog box because the user selected the Start column for 
duplication.

3. Select a column name from the list. 

The column must contain the same type of data for the copy to 
occur. For example, you can copy start timecodes to the Auxiliary 
TC column, but you cannot copy timecodes to the Pullin column.

4. Click OK.

The column of information appears in the column you designated.

When you duplicate a timecode column (Start, TC 24, TC 25, TC 25P, 
or TC 30), the values for master clips and subclips are converted to the 
appropriate timecode. For more information, see “Displaying 
Timecodes in a 24p or 25p Project” on page 155.
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Adding Customized Columns to a Bin

In addition to the standard statistical or film column headings, you 
can add your own column headings to describe information about 
clips. For example, you might want to add a column heading to 
describe what kind of shot (close-up, wide shot, master shot, extreme 
close-up, and so on) is used in a clip.

To add a new custom column:

1. Click an empty area to the right of the current headings in the 
headings box.

2. Move any existing column to the right or left in order to create an 
empty area.

3. Type the column heading you want, and press Enter (Windows) or 
Return (Macintosh). Column headings must contain fewer than 14 
characters, including spaces.

This places the pointer in the data box, beside the first clip in the 
bin.

4. Choose Align to Grid from the Bin menu after you have entered 
the new column heading.

5. Type the information, and press Enter (Windows) or Return 
(Macintosh) to move to the next line.

Changing a Custom Column Heading

You can change the heading name of custom columns only. You cannot 
change any of the standard column headings.

To change the name of a custom column:

1. Press and hold the Alt key (Windows) or Option key (Macintosh), 
and click the heading to highlight it. 

2. Type the new text for the heading, and press Enter (Windows) or 
Return (Macintosh).
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Managing Clip Information in Text View

For additional bin 
shortcuts, see the quick 
reference guide for your 
Avid editing system.

There are several ways to manage clip information in bin columns. 
These methods include copying information between cells, moving 
information between whole columns, sorting clip information, and 
modifying clip data, as described in this section.

Moving Within Column Cells

Use the keyboard shortcuts to move from cell to cell in bin columns:

• Tab: Moves the pointer to the parallel cell in the next column. You 
can continue to press the Tab key to scroll through the cells to the 
right until the cell in the last column is highlighted. The next time 
you press the Tab key, the cell in the first column is highlighted.

• Shift+Tab: Moves the pointer left to the cell in the previous 
column. You can continue to press the Shift+Tab keys to scroll 
through cells to the left until the cell in the first column is 
highlighted. The next time you press Shift+Tab, the cell in the last 
column is highlighted.

• (Windows) Enter key on the main keyboard: Enters any new 
information typed into the cell and moves the pointer down to the 
cell in the next row. You can continue to press Enter to scroll down 
the column until the last cell in the column is highlighted. The next 
time you press the Enter key, the first cell in the column is 
highlighted.

• (Windows) Shift+Enter keys on the main keyboard: Move the 
pointer up to the cell in the previous row. You can continue to 
press the Shift+Enter keys until the cell in the top row is 
highlighted. The next time you press the Shift+Enter keys, the cell 
in the last row is highlighted.

• (Macintosh) Return: Enters any new information typed into the 
cell and moves the pointer down to the cell in the next row. You 
can continue to press Return to scroll down the column until the 
last cell in the column is highlighted. The next time you press the 
Return key, the first cell in the column is highlighted.
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• (Macintosh) Shift+Return: Move the pointer up to the cell in the 
previous row. You can continue to press the Shift+Return keys 
until the cell in the top row is highlighted. The next time you press 
the Shift+Return keys, the cell in the last row is highlighted.

Modifying Clip Information

You can change or modify the information in certain columns for your 
master clips, subclips, tapes, and other objects stored in the bin. This is 
especially useful if some of the data is incorrect, or if you need to 
conform information for organizational purposes.

The following conditions apply to modifying clip information:

• When you modify a clip’s information, related objects are 
automatically updated to reflect the new data. For example, if you 
change the name of a clip, the updated name appears in the 
sequences that use the clip.

• Some data cannot be modified after digitizing because changes 
would prevent you from playing back and editing the material 
successfully.

• Sequence data cannot be changed, even though it appears in your 
bin. The only way to modify sequence data is to edit the sequence 
itself. You can, however, change the name and start time for the 
master timecode track. For more information, see the editing 
guide or user’s guide for your Avid editing system.

There are two ways to modify data:

• You can modify some data directly for master clips, subclips, and 
other objects stored in a bin. 

• You can use the Modify command to change specific information 
for master clips only. 
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Modifying Data Directly

When you modify information in a bin directly, you click a cell and 
type the new information. For example, you can type a new name for a 
clip, or correct the start and end timecodes.

You can directly modify any data in the bin while logging and prior to 
digitizing. After the footage is digitized, however, you can directly 
modify information only in selected headings, with restrictions, as 
shown in Table 5-4.

n For more information on these headings, see “Bin Column Headings” on 
page 158.

Table 5-4 Modifiable Bin Headings

Heading Restrictions

(Clip) Name No restrictions.

Mark IN Altering the mark IN also alters the IN to OUT duration. This replaces 
any previous mark.

Mark OUT Altering the mark OUT also alters the IN to OUT duration. This 
replaces any previous mark.

Color No restrictions.

Color Framing Must be according to tape specifications.

Auxiliary timecodes, 1–5 No restrictions.

KN (Key Number) Start Only for 24p projects, 25p projects, and matchback projects. Altering 
the starting key number also alters the KN End to maintain the 
duration. This can cause discrepancies with any auxiliary timecode 
information you entered manually.

KN (Key Number) End Only for 24p projects, 25p projects, and matchback projects. Altering 
the KN End also alters the KN Start to maintain the duration.
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c Modifying tape names and timecodes will affect any key numbers 
entered for the selected clips.

To modify the clip data directly in a bin:

1. Click the Text tab in the bin to enter Text view.

2. Click the cell you want to modify. Select only one item at a time. In 
this example, the timecode data is highlighted.

3. Click the cell again to enter text.

If the pointer does not change to an I-beam, you might be 
attempting to modify a column that cannot be directly modified.

4. Type the new information, and press Enter (Windows) or Return 
(Macintosh).

Pullin Only for 24p projects and matchback projects. Pullin data imported 
from a telecine-generated list can be altered directly only before 
digitizing or after unlinking. See “Setting the Pulldown Phase” on 
page 189 (NTSC only).

Pullout Automatically calculated. This field cannot be modified.

Table 5-4 Modifiable Bin Headings (Continued)

Heading Restrictions
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Modifying Data Using the Modify Command

The Modify command gives you specialized control over groups of 
clip information. For example, you can use the Modify command to 
change the name of source tapes, or to increment or decrement the 
start and end timecodes by a specified length of time for one or several 
clips at once.

For a complete 
description of the 
Modify dialog box 
options, see the input 
and output guide or 
user’s guide for your 
Avid editing system.

You can apply changes with the Modify command to master clips 
only; subclips cannot be altered in this way. In addition, you can only 
perform modifications that alter the end timecodes or the tracks before 
digitizing, as described in Table 5-5.

Table 5-5 Modify Command Options

Type of Modification Options Description

Set Timecode Drop/ 
Nondrop

Drop, Nondrop Changes the timecode format between 
drop-frame and non-drop-frame. Setting must 
match the timecode format of the tape.

Set Timecode By Field Start or End Changes either the start or end timecode. Only 
start timecode can be altered after digitizing.

Hour, Minutes, Seconds, 
Frames

Allows you to enter custom timecode.

Increment Timecode Start or End Changes either the start or end timecode. 
Incrementing the start timecode automatically 
modifies the end timecode by the same amount. 
Only start timecode can be incremented after 
digitizing.

Timecode text box Allows you to enter custom incremental 
timecode.
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To modify selected data using the Modify command:

1. Open the bin and click the Text tab.

2. Click the icon to the left of the clip or other object you want to 
modify. Ctrl+click (Windows) or Shift+click (Macintosh) each 
additional object you want to modify.

3. Choose Modify from the Special menu.

The Modify dialog box appears.

Decrement Timecode Start or End Changes either the start or end timecode. 
Decrementing the start timecode automatically 
modifies the end timecode by the same amount. 
Only start timecode can be decremented after 
digitizing.

Timecode text box Allows you to enter new decremental timecode.

Set Key Number 
Generic (Prefix)

Key Number text box Allows you to enter a custom generic key 
number. Only for 24p, 25p, and matchback 
projects. See “Entering Key Numbers” on 
page 200.

Set Pullin A, B, C, or D Selects the pulldown phase to match to the 
timecode entry (24p and matchback projects 
only). For more information, see “Entering 
Pulldown Information” on page 194.

Set Tracks V, A1, A2, A3, A4, A5, 
A6, A7, and A8 track 
selector buttons

Changes the clip’s configuration of tracks (film 
projects only). The clip must be unlinked. For 
information on unlinking clips, see the editing 
guide or user’s guide for your Avid editing 
system.

Set Source None Opens the Select Tape dialog box. Selects 
another source tape name for the clips that 
should match the original source tape name.

Table 5-5 Modify Command Options (Continued)

Type of Modification Options Description
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4. Choose an option, such as Set Timecode By Field, from the Modify 
Options pop-up menu.

5. Select an option or type information into the text boxes (timecode 
values, for example) when they appear.

6. Click OK. 

The modification takes effect.

Modify Options 
pop-up menu



152

Organizing with Bins

Copying Information Between Columns

The following procedure describes how to copy all the information in 
one column to another column. The procedure uses an example of 
copying timecode information in one column to a new column. 

To copy column information to another column:

1. Select the timecode column you want to copy.

2. Choose Duplicate from the Edit menu.

The Select dialog box appears, prompting you to target a timecode 
column for the data.

3. Select the target column for the data, and click OK.

Copying Information from Another Cell in a Custom Column

To copy information from another cell in a custom column:

1. Press and hold the Alt key (Windows) or Option key (Macintosh) 
while you click in the destination cell to reveal a pop-up menu of 
all items entered in that column.

2. Select the text from the menu. 

The text appears in the cell.

Sorting Clips in Text View

Sorting clips arranges them in either numerical order, alphabetical 
order, or by color, based on the data in the column you select as the 
sorting criteria. You can sort clips in several different ways, including 
an ascending sort, a descending sort, or a multilevel sort.
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Sorting Clips in Ascending Order

To sort clips in ascending order:

1. With a bin in Text view, click the heading of the column you want 
to use as the criterion.

The column is highlighted.

2. Choose Sort from the Bin menu.

The objects in the bin are sorted in ascending order.

n If the Sort command appears dimmed in the menu, you have not selected a 
column.

To reapply the last sort:

t Choose Sort Again from the Bin menu with no column selected. 

This step is especially useful after you have added new clips to a 
sorted bin.

Sorting Clips in Descending Order

To sort clips in descending order:

1. With a bin in Text view, click the heading of the column you want 
to use as the criterion.

The column is highlighted.

2. Press and hold the Alt key (Windows) or Option key (Macintosh) 
while you choose Sort Reversed from the Bin menu.

The objects in the bin are sorted in descending order.
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Multilevel Sorting with Columns

You can select multiple columns in a bin and perform a multilevel sort 
using the information in the columns.

To perform a multilevel sort using the information in the bins:

1. With a bin in Text view, arrange the columns in the bin to establish 
the primary column.

The column that appears farthest to the left in Text view becomes 
the primary criterion for the sorting operation. 

2. Select the columns you want to sort.

The columns are highlighted.

3. Choose Sort from the Bin menu.

The objects in the bin are sorted.

Sorting Clips by Color

You can sort the clips by color if you assigned colors to the clips. See 
“Assigning Colors to Bin Objects” on page 130.

To sort clips by color:

1. Click the Color column heading in the bin.

2. Choose Sort from the Bin menu.

The objects in the bin are sorted by color.

n Colors are sorted by hue, saturation, and value.
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Displaying Timecodes in a 24p or 25p Project

When you are working with 24p and 25p projects, you can add 
timecode columns to bins to enter and display starting timecodes in 
several timecode formats for master clips and subclips.

After you add a timecode column (TC 24, TC 25, TC 25P, or TC 30) to a 
bin, you can use the Duplicate command to convert the values for 
master clips and subclips to the appropriate timecode for that column.

For example, when working with a 24p NTSC project, if you duplicate 
the Start column values to one of the timecode columns and the Start 
column contains a master clip with the timecode 01:00:00:15, the 
timecode is converted to the timecode of that column.

Table 5-6 shows the converted timecode for each timecode column. All 
of the values are equivalent.

n The TC1 track in the Timeline represents the timecode of the project in which 
you are working. For example, when you are working in a 24p NTSC project, 
the TC1 track displays the same timecode as the TC 30 track.

Table 5-6 Timecode Columns

Bin Column Timecode

TC 24 01:00:00:15

TC 25 01:00:00:15

TC 25P 01:00:00:16

TC 30 01:00:00:19



156

Organizing with Bins

Frame Counting for Timecodes

Table 5-7 shows the frame count for each of the timecodes. The 
timecodes are listed as 24 for 24 fps, 25 for 25 fps, 25P for 25 (PAL with 
pulldown), and 30 for 30 fps (the count skips 6 frames to fit 30 frames 
into 24 fps).

Adding Timecode Columns to a Bin

To add timecode columns to a bin:

1. Choose Headings from the Bin menu.

The Bin Column Selection dialog box appears.

2. Ctrl+click (Windows) or click (Macintosh) the timecode columns 
you want to display. 

3. Click OK.

The timecode columns appear in the bin.

Table 5-7 Timecode Frame Counts for Record

Timecode Frames

24 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 00

25 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

25P 00 01 02 03 04 05 06 07 08 09 10 11 13 14 15 16 17 18 19 20 21 22 23 24 00

30 00 01 03 04 05 06 08 09 10 11 13 14 15 16 18 19 20 21 23 24 25 26 28 29 00
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Adding Timecode Values to the Timecode Columns

To add timecode values to the timecode columns:

1. Open a bin.

2. Add the Start column and the timecode column with the format 
you want to use.

3. Select the Start column.

4. Choose Duplicate from the Edit menu.

The Select dialog box appears.

5. Select the timecode heading from the list.
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6. Click OK.

The values for master clips and subclips in the Start column are 
converted to the appropriate timecode format and entered into the 
column you selected.

Bin Column Headings

You can select individual or multiple headings to be displayed or 
hidden in a bin. Table 5-8 describes the Bin Column Selection 
headings. For a procedure on how to select column headings, see 
“Showing and Hiding Columns” on page 140.

Table 5-8 Bin Column Selection

Heading Description

Name This heading does not appear as a column selection, but it always appears in 
the bin. The column contains the name of the clip (you can rename a clip after it 
has been digitized). 

Audio The audio resolution (sample rate).

Audio Format The audio format of master clips (AIFF-C, SDII, or WAVE).

Auxiliary Ink Auxiliary ink format settings allow you to display two types of ink numbers at 
the same time. This lets you track additional types of film information for 
different film gauges. Used for 24p projects, 25p projects, and matchback 
projects only.

Auxiliary TC1 
through TC5

You can enter an auxiliary timecode, such as Aaton® or Arri®, or another 
timecode for editing film or audio timecode for film. (Not restricted to film 
projects.)

CFPS The captured frames per second.

Camera The camera used to film this clip. This feature is used in multicamera shoots.
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Camroll The camera roll containing this clip. Used for 24p projects, 25p projects, and 
matchback projects only.

Color The color of the bin objects for organizing the objects.

Color Framing The color framing for the tape. For NTSC, the choice is Even or Odd. For PAL, 
the choices are A Standard, A Non-Standard, B Standard, or B Non-Standard.

n After you add the column to the bin, click in the column and choose a color 
framing option from the pop-up menu.

Creation Date The date and time the clip was logged or digitized.

Disk The last known drive on which the media for that master clip existed.

Duration The length of the clip.

End The timecode of the clip’s tail frame.

FPS The play rate: the number of frames to be displayed each second. The default is 
30 for NTSC and 25 for PAL for video.

Film TC The timecode used on film. Used for 24p and 25p projects only.

Frame Displays the same frame that is displayed when you select Frame view for the 
bin. The frame will only appear in the bin after the media is digitized in the 
Avid editing application.

IN-OUT The length of the marked segment, if any.

Ink Number The ink number for the clip. Used for 24p projects, 25p projects, and matchback 
projects only.

KN Duration The length of the clip, expressed in feet and frames. Used for 24p projects, 25p 
projects, and matchback projects only.

KN End The ending key number for the clip. Used for 24p projects, 25p projects, and 
matchback projects only.

Table 5-8 Bin Column Selection (Continued)

Heading Description
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KN IN-OUT The Mark IN and Mark OUT key number for the clip. Used for 24p projects, 
25p projects, and matchback projects only.

KN Mark IN The key number for the IN point, if you set one for the clip. Used for 24p 
projects, 25p projects, and matchback projects only.

KN Mark OUT The key number for the OUT point, if you set one for the clip. Used for 24p 
projects, 25p projects, and matchback projects only.

KN Start The starting key number for the clip. Used for 24p projects, 25p projects, and 
matchback projects only.

Labroll The labroll containing the clip.

Lock Specifies whether the clip is locked against deletion.

Mark IN The timecode for the IN point, if you set one for the clip.

Mark OUT The timecode for the OUT point, if you set one for the clip.

Modified Date The date and time a sequence was last edited or changed.

Offline The track names for any media files that are offline.

Perf The film edge perforations format used for 3-perf projects. Used for 
24p projects, 25p projects, and matchback projects only.

Project The project under which the media was originally digitized.

Pullin The telecine pulldown of the first frame of the clip (pulldown phase). Pullin 
can have the values A, B, C, or D. Used for 24p projects and matchback projects 
only (NTSC only).

Pullout The telecine pulldown of the last frame of the clip (pulldown phase). Pullout 
can have the values A, B, C, or D. Used for 24p projects and matchback projects 
only (NTSC only).

Reel # The source reel number. Used for 24p and 25p projects only.

Table 5-8 Bin Column Selection (Continued)

Heading Description
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Scene The scene number of the clip.

Shoot date The date the footage was shot.

Slip The number and direction of perfs for subclips (audio clips only). Used for 
24p and 25p projects only.

Sound TC The timecode for audio.

Soundroll The sound roll this clip came from. Used for 24p projects, 25p projects, and 
matchback projects only.

Start The timecode of the clip’s head frame.

TC 24 The 24-fps timecode. Used for 24p and 25p projects only.

TC 25 The 25-fps timecode, no pulldown. Used for 24p and 25p projects only.

TC 25P The 25-fps timecode with PAL pulldown. Used for 24p and 25p projects only.

TC 30 The 30-fps timecode with 2:3 pulldown. Used for 24p and 25p projects only.

Take The take number of the scene.

Tape The source tape name.

Tracks All tracks used by this media object.

VITC The vertical interval timecode.

Video The resolution under which the media for that clip was digitized.

Table 5-8 Bin Column Selection (Continued)

Heading Description
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CHAPTER 6
Creating MediaLog Output

Once you have finished logging your tapes, you can print the bins to 
create a paper record of your log, export the bin files for use in a 
different application, or transfer the bins to an Avid editing system for 
digitizing and editing the footage.

This chapter covers the following topics:

• Printing Bins

• Exporting Bins

• Transferring Bins to an Avid Editing System
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Printing Bins
Before you print MediaLog bins, make sure a printer driver has been 
installed and your computer recognizes the driver. If the driver is 
installed properly, simply restarting your computer will cause the 
system to recognize the driver.

n Directions for installing the printer driver and selecting the 
printer should be included in the documentation for your printer and for your 
computer system.

The Avid application allows you to print entire bins or individual 
frames in hardcopy form.

To print entire bins in Brief or Text view:

1. Make sure your printer is correctly set up. See the Windows Help 
or your system administrator.

2. Click the Brief tab (Brief view) or Text tab (Text view) of the bin to 
select the view you want to print.

3. Choose Page Setup from the File menu. 

The Page Setup dialog box appears, reflecting the specific options 
for your printer.

4. Select the Page Setup options. 

5. Click OK (Windows) or click Print (Macintosh).

6. Choose Print Bin from the File menu. 

The Print dialog box appears, reflecting the specific options for 
your printer.

7. Select the Print options.

8. Click OK (Windows) or click Print (Macintosh).

The system prints the active bin.
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Exporting Bins
You can save the bin information in a text file for use with other 
applications. The information is saved in an ASCII file (TAB 
Delimited) and is organized in the following way:

• Line 1 is a list of the headings in the current Bin view. This line is 
optional.

• Each remaining line is data for an individual clip, with tabs 
delimiting each category of information. These lines are separated 
by carriage returns.

The file can be opened in any word processing or text editing package, 
or it can be imported into a database file created by applications like 
Microsoft Excel and Claris® FileMaker®.

The information can also be saved as a shot log in Avid format (ALE) 
for importing to an Avid editing system bin. This is generally 
unnecessary, because MediaLog bins can also be opened directly in 
Avid editing applications.

To export a MediaLog bin:

1. Open the bin that contains the clips you want to export.

2. Select the clips.

3. Choose Export from the File menu.

A dialog box appears.

4. Select the format you want to use for the exported bin.

The Export As dialog box appears.
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5. Navigate to the disk and folder where you want to save the 
exported file.

6. Click Save to accept the default file name, or type a new file name 
and then click Save.

Windows

Macintosh
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Transferring Bins to an Avid Editing System
Bins you have created on a MediaLog system can be transferred to an 
Avid editing system and then opened directly from within an Avid 
editing project.

The clips logged in the transferred bins are ready for batch digitizing; 
no additional preparation is required.

It is best to transfer only bins, without projects, to the Avid editing 
system. Then if you want, you can digitize the bins using a different 
video resolution.

You can transfer bins in the same way you transfer any files: on a 
floppy disk, removable disk, or over a network.

To transfer MediaLog bins to an Avid editing system:

1. On your computer desktop, locate and double-click the Avid 
Projects folder in the Select User and Project dialog box (see 
“Setting Up Project Files and Folders” on page 35).

2. Double-click the project from which you want to transfer bins.

3. Select the bins you want to transfer. 

4. Copy the MediaLog bins to a formatted floppy disk, removable 
disk, or network drive.

5. At the Avid editing system, quit the Avid editing application, if it 
is open.

6. Double-click the Avid Projects folder. Then double-click the 
project folder where you want to store MediaLog bins.

7. If using a floppy disk for transfer, insert the floppy disk into the 
Avid editing system floppy drive.

8. Double-click drive icon.
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9. Select the MediaLog bins, and copy them into the appropriate 
project folder.

10. Start the Avid editing system and open the project.

The MediaLog bins appear in the list of bins.



APPENDIX A
Avid Log Specifications

This section explains the Avid log file format. The Avid application can 
import logs that meet Avid log specifications. These logs must follow 
the formatting requirements.

This appendix covers the following topics:

• Supported Avid Log Formats

• Understanding Avid Log Specifications

• Describing an Avid Log File

• Sample Avid Logs
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Supported Avid Log Formats
Table A-1 lists the log formats that can be imported into the Avid 
application. You can use a text editor to adapt other log formats so 
they meet Avid log specifications.

Table A-1 Compatible Log Formats

Log Requirements File Name Extension

AatonBase Conversion required .atn or .atl

Avid Logs Create with text editor 
and import directly

.ale

CMX EDL Conversion required .cmx

Evertz Import directly 
(conversion optional)

.ftl

Excalibur Conversion required .ale or .flx

FLEx Conversion required .flx

Keyscope Import directly .ksl

Log Producer Conversion required .llp

Log Right Import directly .ale

OSC/R Conversion required .asc
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Understanding Avid Log Specifications
This section contains tables that show how to enter headings and data 
to create an Avid log. The tables use the following conventions:

• <A supported value> is surrounded by angle brackets. 
<Alternative supported values> appear underneath, also in angle 
brackets. You must enter exactly one of these values. For example, 
<29.97> is one of the supported values for the FPS heading; to 
specify that value, type 29.97.

• <A variable data value> is also surrounded by angle brackets. For 
example, <time code> is the data entry for the Start heading; type 
the correct timecode, in the format 08:19:10:00 (or 
08;19;10;00, for drop-frame timecode).

• [Tab] and [Enter] (Windows) and [Return] (Macintosh) keys are 
surrounded by standard brackets.

• The fifth column contains the word “Required” if the heading 
must be included in the log.

• The final column contains notes about the heading or values.

The following is a sample heading from the format table:

Note that FPS is a required heading. 

To make a log entry for the FPS heading:

1. Type FPS. 

2. Press the Tab key. 

FPS [Tab] <25>

<29.97> [Enter] or 
[Return]

Required Capture rate is 25 fps for PAL and 
29.97 fps for NTSC video. 
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3. Type one of the supported values (25 or 29.97).

4. Press Enter (Windows) or Return (Macintosh).

Describing an Avid Log File
An Avid log is composed of three or four sections, in this order:

• Global headings 

• Column headings

• Custom column headings (optional)

• Data headings

The tables in this section adhere to this order. When you create an Avid 
log, you must follow the order precisely.

You can select not to display a defined heading (including a required 
heading), except for Name. Name must always be displayed.

The maximum number of combined global, standard, and custom 
headings in a log file is 64. 

Global Headings

The global headings must come first in an Avid log file, and you must 
enter one value for each heading.

Table A-2 shows the format for the global headings and the supported 
values for each heading.
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Table A-2 Avid Log Global Headings

GLOBAL HEADINGS: Global headings are case sensitive and must be spelled exactly as shown. 
Include all required headings. Other headings are optional but might be necessary for your project. 
The maximum number of combined global, standard, and custom headings in a log file is 64.

Heading [Enter] or 
[Return]

Required This marks the start of the 
global headings.

FIELD_DELIM [Tab] <TABS> [Enter] or 
[Return]

Required Enter TABS to show that the file 
is TAB Delimited.

VIDEO_FORMAT [Tab] <NTSC>

<PAL> [Enter] or 
[Return]

Required

AUDIO_FORMAT [Tab] <22 kHz>

<24 kHz>

<44 kHz>

<48 kHz> [Enter] or 
[Return]

Audio sampling rate for 
digitizing. You can override this 
for individual clips.

TAPE [Tab] <Tape 
Name>

[Enter] or 
[Return]

Required Name of the videotape reel you 
are logging. If you omit this 
heading, the file name becomes 
the global tape name. You can 
override this for individual 
clips.
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Column Headings

The standard column headings appear after the global headings in the 
Avid log file. You do not enter the data for a column heading along 
with the heading. You will enter the data later, in a separate data 
section.

You must include the five required standard column headings; they 
are listed first in Table A-3.

You can create your own custom column headings. Enter them after 
the standard headings (see the last heading in this table). To create a 
custom heading, substitute the custom heading name for 
<Your_heading>. You can create several custom headings, as long as 
the total of global, standard, and custom headings does not exceed 64.

FPS [Tab] <25>

<29.97> [Enter] or 
[Return]

Required Capture rate is 25 fps for PAL 
and 29.97 fps for NTSC video. 

[Enter]
or 
[Return]

Press Enter (Windows) or 
Return (Macintosh) a second 
time after entering the FPS 
value. This marks the end of the 
global headings.

Table A-2 Avid Log Global Headings (Continued)

Table A-3 Avid Log Column Headings

COLUMN HEADINGS: Column headings are case sensitive and must be spelled exactly as shown. 
The first five headings are required. Other headings are optional but might be necessary for your 
project. The maximum number of combined global, standard, and custom headings in a log file is 64.

Column [Enter] 
or 
[Return]

Required Indicates the start of the column headings.
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Name [Tab] Required Heading for clip name. 

Tracks [Tab] Required Heading for tracks you select for digitizing. 

Start [Tab] Required Heading for video timecode of sync point — the 
timecode IN for clip. From address track of video. 

End [Tab] Required Heading for timecode OUT for clip. From address 
track of video.

AUDIO_FORMAT [Tab] Heading for audio sampling rate for digitizing the 
individual clip. If omitted, the global entry for 
AUDIO_FORMAT applies.

Auxiliary TC1 [Tab] Heading for auxiliary timecode.

Auxiliary TC2 [Tab] Heading for auxiliary timecode.

Auxiliary TC3 [Tab] Heading for auxiliary timecode.

Auxiliary TC4 [Tab] Heading for auxiliary timecode.

Auxiliary TC5 [Tab] Heading for auxiliary timecode.

CFPS [Tab] Heading for video capture rate for digitizing the 
individual clip. If omitted, the global entry applies.

Color Framing [Tab]

Creation Date [Tab] Heading for date of clip creation.

Disk [Tab] Heading for target disk ID.

Duration [Tab] Heading for timecode Start to timecode End; the 
length of the video clip.

FPS [Tab] Heading for video frames per second rate for 
digitizing the individual clip (NTSC = 29.97, PAL = 
25). If omitted, the global entry applies.

Table A-3 Avid Log Column Headings (Continued)
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IN-OUT [Tab] Heading for duration between clip’s mark IN and 
mark OUT (if present).

Mark IN [Tab] Heading for timecode of clip’s mark IN (if present).

Mark OUT [Tab] Heading for timecode of clip’s mark OUT (if present).

Offline [Tab] Heading for tracks currently without digitized media 
files online.

Tape [Tab] Heading for source tape ID for the individual clip. If 
omitted, the global entry applies.

Video [Tab] Heading for video resolution.

Labroll [Tab] Heading for lab roll ID for clip. Lab rolls are a 
combination of several camera rolls.

Camroll [Tab] Heading for camera roll ID for clip.

Sound TC [Tab] Heading for Nagra time code, Aaton code, Arri code, 
and so on, at the sync point. Syncs with the Start 
timecode. Required if tracking the sync sound. 
Capture rate can be 25 or 30 fps.

Soundroll [Tab] Heading for sound roll ID for clip.

Scene [Tab] Heading for scene ID for clip. 

Take [Tab] Heading for take ID for clip. 

TC 24 [Tab] Heading for 24-fps timecode

TC 25P [Tab] Heading for 25-fps timecode with pulldown

TC 25 [Tab] Heading for 25-fps timecode

TC 30 [Tab] Heading for 30-fps timecode

DESCRIPT [Tab] Heading for description of clip.

Table A-3 Avid Log Column Headings (Continued)



177

Describing an Avid Log File

Data Headings

Some data, such as 
Creation Date, is 
gathered by the system. 
Table A-4 does not 
include entries for such 
data.

The data headings come after the Custom column headings. Table A-4 
shows the format for entering data. Enter a line of data in this format 
for every clip. Be sure to start the data section for each clip with the 
word Data [Enter] (Windows) or Data [Return] (Macintosh).

You must enter data so that it aligns with its column heading. For 
example, the data that goes with the ninth column heading must be 
the ninth data entry.

Be sure to enter data for all the required values. To leave a data 
position unfilled, press the Tab key instead of typing data. Press Enter 
(Windows) or Return (Macintosh) at the end of each line.

COMMENTS [Tab] Heading for comments about clip.

<Your_heading> [Tab] Press the Tab key between each heading. Do not press 
the Tab key after the last heading. Add any category 
of information you want. Add as many headings as 
you want, but do not use more than a total of 64 global 
and column headings in the file.

[Enter] 
or 
[Return]

[Enter] 
or 
[Return]

Press Enter (Windows) or Return (Macintosh) twice 
(do not press Tab) after the last heading.

Table A-3 Avid Log Column Headings (Continued)

Table A-4 Avid Log Data Headings

DATA HEADINGS: The word Data marks the start of the data for each clip.

Data [Enter]
or 
[Return]

Required Enter the word Data to mark the start of the logged clip 
entries.
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DATA FOR EACH CLIP: Enter a line of data for each clip. Enter the data so that it aligns with its column 
heading. (The data that goes with the ninth column heading must be the ninth data entry.) Be sure to 
enter data for all the required values. To leave a data position unfilled, press the Tab key instead of 
typing data. Press Enter (Windows) or Return (Macintosh) at the end of each line. Your Avid system 
supports up to four audio tracks in imported and exported logs.

<clip name> [Tab] Required Under Name heading. Enter a clip identifier (32 
characters maximum). 

<V>

<VA1>

<VA2>

<VA1A2>

<A1A2>

<A1>

<A2> [Tab] Required Under Tracks heading. Enter the tracks you want 
digitized for the clip. Enter V for MOS takes. Enter A1, 
A2, or A1A2 for wild sound.

<22 kHz>

<24 kHz>

<44 kHz>

<48 kHz> [Tab] Under AUDIO_FORMAT heading. Enter the audio
sampling rate for this clip only. If omitted, global entry 
applies.

Table A-4 Avid Log Data Headings (Continued)
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<Source tape ID> [Tab] Under Tape heading. Enter the source videotape ID for 
this clip only.

<25>

<29.97> [Tab] Under FPS heading. Enter the video capture rate for this 
clip only. If omitted, global entry applies. Use 25 fps for 
PAL video or 29.97 fps for NTSC video.

<time code> [Tab] Required Under Start heading. Enter the video timecode for sync 
point, the first frame in clip. Use colons for 
non-drop-frame (for example, 01:00:12:20). Use one or 
more semicolons for drop-frame (for example, 
01;18;00;02).

<time code> [Tab] Required Under End heading. Enter the video timecode for the last 
frame of clip.

<time code> [Tab] Under Duration heading. Enter the length of the video 
clip, Start to End.

<lab roll ID> [Tab] Under Labroll heading. Identify the lab roll using letters 
and numbers.

<camera roll ID> [Tab] Under Camroll heading. Identify the camera roll using 
letters and numbers.

<time code> [Tab] Under Auxiliary TC heading. Enter a Nagra timecode, 
Aaton code, Arri code, and so on, for the sync point. 
Syncs with the Start timecode.

<Sound roll ID> [Tab] Under Soundroll heading. Identify the sound roll using 
letters and numbers.

<scene ID> [Tab] Under Scene heading. Identify the scene using letters and 
numbers.

<take ID> [Tab] Under Take heading. Identify the take using letters and 
numbers.

<clip description> [Tab] Under DESCRIPT heading. Describe the clip.

Table A-4 Avid Log Data Headings (Continued)
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Sample Avid Logs
This section contains a sample Avid log for an NTSC video project.

Formatting keys (such as [Tab] and [Enter] (Windows) and [Return] 
(Macintosh)) are shown in brackets.

<clip comments> [Tab] Under COMMENTS heading. Comment on the clip.

<information> [Tab] Press the Tab key between each heading. Do not press the 
Tab key after last heading. Under the headings you 
created yourself, type the appropriate information.

[Enter] or [Return] Press Enter (Windows) or Return (Macintosh) after the 
last entry for the clip. 

Do not press Tab after the last entry for the clip.

Enter an additional line of data for each remaining clip.

Table A-4 Avid Log Data Headings (Continued)
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Heading [Enter]

FIELD_DELIM [Tab] TABS [Enter]

VIDEO_FORMAT [Tab] NTSC [Enter]

AUDIO_FORMAT [Tab] 44kHz [Enter]

TAPE [Tab] 001 [Enter]

FPS [Tab] 29.97 [Enter]

[Enter]

Column [Enter]

Name [Tab] Tracks [Tab] Start [Tab] End [Enter]

[Enter]

Data [Enter]

CU Josh & Mary [Tab] V [Tab] 01:00:00:00 [Tab] 01:15:05:00 [Enter]

CU Josh [Tab] VA1 [Tab] 01:15:06:00 [Tab] 01:20:00:00 [Enter]

Windows

Heading [Return]

FIELD_DELIM [Tab] TABS [Return]

VIDEO_FORMAT [Tab] NTSC [Return]

AUDIO_FORMAT [Tab] 44kHz [Return]

TAPE [Tab] 001 [Return]

FPS [Tab] 29.97 [Return]

[Return]

Column [Return]

Name [Tab] Tracks [Tab] Start [Tab] End [Return]

[Return]

Data [Return]

CU Josh & Mary [Tab] V [Tab] 01:00:00:00 [Tab] 01:15:05:00 [Return]

CU Josh [Tab] VA1 [Tab] 01:15:06:00 [Tab] 01:20:00:00 [Return]

Macintosh
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APPENDIX B
Working with a Film Project

This appendix covers the following topics:

• Creating a Film Project

• Film Settings

• Logging Film Information

n The information in this appendix also applies to matchback projects. 
Matchback is available in Symphony, Media Composer, Film Composer, and 
Avid Xpress systems.

n Film projects that use 24p and 25p media are only available in Symphony, 
Media Composer, and Film Composer systems. For information on film 
projects, see the appropriate editing guide and input and output guide.
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Creating a Film Project
This section describes how to create a film project.

Creating a New Project

To create a new project:

1. Click New Project in the Select User and Project dialog box.

The New Project dialog box appears.

2. Type a name for your new project in the text box and click OK.

n If you plan to move bins and projects from one platform to another, do not use 
the characters / \ : * ? “ < > | when naming projects, bins, and users. 

3. Choose a project type from the Format pop-up menu, based on 
your source footage (NTSC or PAL) and your Avid system model: 

- If your Avid system does not include support for 24p projects 
or 25p projects, make a selection based on the source footage: 
NTSC or PAL.

- If your Avid system includes support for 24p projects or 25p 
projects, make a selection based on the source footage or the 
type of film-to-tape transfer you are working with.
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Table B-1 lists the format options available with Avid systems 
that include support for 24p projects and 25p projects.

4. Choose a tracking format or audio transfer rate:

- For 24p projects and 25p projects, choose a film gauge tracking 
format from the Film Type pop-up menu.

- For 24p PAL projects, choose an audio transfer rate. For 
information on audio transfer rates, see the input and output 
guide for your Avid editing system.

5. (Option) Click Matchback and choose a film tracking format from 
the Film Type pop-up menu. The Matchback item appears only if 
your Avid system includes the Matchback option.

6. Click OK.

The system creates the new project files and folders, and then 
returns you to the Select User and Project dialog box. The project 
name is highlighted in the Projects scroll list.

Table B-1 Project Types for Systems That Support 24p and 
25p Projects

Project Type Source Footage Transfer

24p NTSC For film-originated or other 24-fps footage 
transferred to NTSC videotape

30i NTSC For NTSC video-originated or other 30-fps footage 
transferred to NTSC videotape

24p PAL For film-originated or other 24-fps footage 
transferred to PAL videotape at 25 fps

25p PAL For 25-fps film footage transferred to PAL 
videotape

25i PAL For PAL video-originated footage (25 fps)
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Film Settings
Set film preferences in the Film Setting dialog box immediately after 
you create a project to provide the system with important information 
about the type of film and audio transfer you used for your job. You 
can access the Film Settings from the Settings scroll list in the Project 
window. The following illustration shows the dialog box for an NTSC 
film project. A PAL project replaces the Picture Transfer Rate menu 
with an Audio Transfer Rate menu.
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Film settings determine essential parameters for accurately capturing, 
tracking, and editing source material for 24p and 25p projects. 
including:

• Audio transfer rate (PAL only) and pulldown parameters for 
film-to-tape transfers

• Format and display of ink numbers

Setting the Format and Display of Ink Numbers

Table B-2 describes the Film Settings options for setting the format and 
display of ink numbers. 

See “Entering the Ink Number (Optional)” on page 202 for more 
information.

Table B-2 Film Setting Dialog Box Options

Option Description

Ink Number Format Selects one of these industry-standard ink number formats to meet 
your production lab standards and your film format.

Ink Number displayed as Selects the format for the ink number display in bins and cut lists. 

Auxiliary Ink Format Selects the format for a second ink number (this is useful for tracking 
additional information for different film gauges). The choices are the 
same as for Ink Number Format.

Auxiliary Ink displayed as Selects the format for the auxiliary ink number display. The choices are 
the same as for Ink Number displayed as.
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Transfer Settings for Film Projects

The following settings are important for transferring media in a film 
project. You should set the transfer settings for film projects 
immediately after you create a new project and before digitizing.

• (NTSC only) Picture Transfer Rate allows you to specify the type 
of film-to-tape transfer that you digitize:

- Without pulldown: Select this option when working with 24-fps 
footage that has been transferred MOS (roughly translated as 
“without sound”) to 30 fps by speeding up the film, and the 
audio has been brought into the Avid system separately at 
100% of the actual speed.

- With 2:3 pulldown: Select this option when working with 24-fps 
footage that has been transferred to 30 fps by duplicating 
frames (pulldown), and the audio has been synchronized to 
the picture.

If you are digitizing sound that has been created during an NTSC 
film-to-tape transfer, you need to set the pulldown switch before 
you begin digitizing.

For NTSC projects, you can mix footage transferred with 
pulldown and footage transferred without pulldown (video rate). 
You can also mix sound transferred at 0.99 (with pulldown) and 
1.00 (without pulldown).

• (PAL only) You define the Audio Transfer Rate in the New Project 
dialog box when you create a 24p PAL film project. (It is not 
needed for a 25p PAL project because there is no film speedup 
during the transfer.) It is important to keep the audio transfer rate 
constant for the project. However, if there is a specific element you 
need to digitize at a different rate, you can use the Film Setting 
dialog box to change the rate. The following options are available:

- Film Rate (100%): Select this option when your 24-fps film 
footage has been transferred MOS to 25 fps by speeding up 
the film, and the audio comes in separately at 100% of the 
actual speed (PAL Method 2).
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- Video Rate (100%+): Select this option when your 24-fps film 
footage has been transferred to 25 fps by speeding up the film, 
and the audio is synchronized to the video picture. This 
means the audio speed is increased by 4.1 percent (PAL 
Method 1).

For PAL 24p projects, you can mix audio that has been transferred 
at 4.1 percent speedup (video rate, PAL Method 1) with audio that 
has not been transferred (film rate, PAL Method 2). However, Avid 
does not recommend this. For more information, see the editing 
guide for your Avid editing system.

n The Info tab in the Project window allows you to view the audio transfer rate 
you selected when you created the project. The actual audio transfer rate 
might be different from the display if you used the Film Setting dialog box to 
change the audio transfer rate.

• Set Pulldown-to-Timecode Relationship allows you to set a 
default pulldown phase for a 24p NTSC project. See “Determining 
the Pulldown Phase” on page 196.

Setting the Pulldown Phase

If you are logging or digitizing 24-fps sources (film-to-tape transfers, 
media downconverted from 1080p/24 footage, or both), you can set 
the pulldown-to-timecode relationship for a transferred tape in the 
Film Setting dialog box. 

n The information in this section only applies to NTSC projects.

Set Pulldown 
Phase option
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You set this relationship by selecting the pulldown phase (sometimes 
called the pulldown frame or pullin frame), which is the video frame at 
which the master clip starts. The pulldown phase is designated A, B, 
X, C, or D. Film labs and transfer houses typically use the A frame to 
start the transfer.

The following illustration shows the relationship between film frames 
and video frames.

n This setting is not available in matchback projects. However, you can modify 
the pulldown phase after you log it. See “Entering Pulldown Information” on 
page 194.

The Set Pulldown Phase option lets you log, digitize, and 
digitize-on-the-fly more easily, because the correct pulldown phase of 
any IN point for a particular tape is automatically determined. Setting 
the correct pulldown phase prevents inaccuracies in cut lists and 
matchback EDLs. It also prevents incorrectly digitized clips that 
appear to stutter when played in 24p NTSC projects.

For example, if you set the pulldown phase of 00:00:00:00 as A 
(indicating that the A frame is located at timecodes ending in 0 or 5), 
any timecode you log will calculate its pulldown phase based on the 
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same sync point, regardless of where you set the IN point. If you use 
the Digitize tool to log a clip that starts at 01:00:10:01, the Avid system 
automatically enters B in the Pullin column of the bin. If you digitize 
with an IN point at 01:00:10:01, the system begins to digitize at the 
next A frame, in this case, 01:00:10:05.

The pulldown-to-timecode relationship might vary from tape to tape, 
or within the same tape, depending on how the footage was 
transferred. If you find a tape requires a different pulldown phase, you 
can change the setting in the Film Setting dialog box, or use the 
Modify Pulldown Phase dialog box before digitizing (see “Modifying 
the Pulldown Phase Before Digitizing” on page 198.

To set the pulldown phase:

1. Determine the correct pulldown phase for 00:00:00:00 in one of the 
following ways:

t If you are digitizing film-to-tape transfers, check the transfer 
log.

t If you are digitizing tapes that have been downconverted 
from 1080p/24, check what pulldown frame was set for 
00:00:00:00 on the deck that performed the conversion.

If you still cannot determine the pulldown phase, see 
“Determining the Pulldown Phase” on page 196. 

2. Double-click Film in the Settings scroll list of the Project window.

3. Select the option Set Pulldown Phase of Timecode 00:00:00:00 and 
then choose the correct pulldown phase (A, B, X, C, D) from the 
pop-up menu.

4. Click OK.
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Logging Film Information
Once you have entered or imported the basic log information into a 
bin, you might want to add film-related log information before 
digitizing. This section describes procedures and formats for adding 
various film headings.

The following are some important requirements for film-based 
projects:

• The minimum information required for digitizing is the data 
recorded in the Start and End video timecode columns, and the 
pulldown phase for NTSC transfers, which is noted in the Pullin 
column (24-fps capture only).

• Each reel of film can be logged as a separate clip, and will 
correspond to a single master clip, only if the video transfer of the 
film reel has continuous pulldown (NTSC format) and continuous 
timecode (NTSC and PAL). If the film reels for your project do not 
meet this condition, then you must log each take on a reel of film as 
a separate clip, which will correspond to a single master clip.

• If you want to produce a cut list, or use film-tape-film-tape for 
redigitizing, you must log key numbers. You can add key numbers 
after digitizing, before you create the cut list. 

• All film and video reference numbers must be in ascending order. 
For example, you cannot have key numbers in descending order.
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Displaying Film Columns

To display film columns in the bin:

1. Choose Film from the Bin View pop-up menu, which is located at 
the bottom of the Bin window, to display all the required film 
column headings.

2. To log data under optional headings (for example; Ink Number, 
Auxiliary TC1 through Auxiliary TC5, or Film TC), choose 
Headings from the Bin menu and Ctrl+click (Windows) or click 
(Macintosh) the specific headings you want to add from the Bin 
Column Selection dialog box.
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3. You can also track custom information for the job by creating a 
custom heading. To create a new heading, type a name that 
describes the information in the headings bar at the top of the bin. 
For more information on customizing bin views, see 
“Customizing Bin Views in Text View” on page 124.

Entering Pulldown Information

For information about 
importing a log file, see 
“Importing Logs” on 
page 110.

To accurately digitize NTSC transfer tapes in 24p projects, you need to 
enter pulldown information into the bin. (This information is not 
required for PAL transfer tapes.) Setting the correct pulldown phase 
prevents inaccuracies in cut lists and matchback EDLs. If you are 
importing a log generated during the telecine transfer, the pulldown 
information is automatically included in the bin.
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You specify the pulldown phase in the Pullin column. The following 
illustration shows a bin with a Pullin column.

If you do not have a transfer log, or if the transfer log is incorrect, you 
need to add the information manually. If you log clips using the 
Logging tool, the Avid system uses the A frame as the default 
pulldown phase. You might need to edit this value.

n You can set a default pulldown phase in the Film Setting dialog box. See 
“Setting the Pulldown Phase” on page 189 (24p projects only).

n For matchback projects, you need to log key number information before you 
can log pulldown information.

By specifying the pulldown phase in the Pullin column, you 
accomplish the following:

• You ensure the clips will start with the correct frame for the 
pulldown. Otherwise, you might experience inaccuracies in 
key-number tracking and in the cut lists. 

• You indicate where the pulldown fields are located so the Avid 
system can accurately eliminate the pulldown fields during the 
digitizing process, leaving you with a frame-to-frame 

Start timecode Pullin column
(information required for NTSC)
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correspondence between your digital media and the original 
24-fps footage (24p projects only).

To do this, you must indicate whether the sync point at the start of 
each film clip transferred to tape is an A, B, C, or D frame, as described 
in the following section. In most cases, the sync point is the A frame.

Determining the Pulldown Phase

It is easiest to determine the pulldown of a sync point (or pulldown 
phase) if you ask your film lab to keypunch (cut a small hole in) the 
sync frame at the zero frame in the original film footage before 
transferring the film to video. Many film labs or transfer houses can 
also provide a pulldown frame indicator displayed at the far right of 
the burn-in key numbers, depending on the equipment available. 
Ideally, the A-frame pulldown coincides with timecode ending in 
0 and 5 (:00, :05, :10, and so on).

If the footage has not been keypunched, you can determine pulldown 
according to clapsticks or any other distinctive frame at the beginning 
of the clip. Determining the pulldown is easier if the frames depict 
motion.

To determine the pulldown phase:

1. While viewing the video transfer on a monitor, go to the 
keypunched (or clapsticks) sync point for the beginning frame of 
the clip you’re logging.

2. Step (jog) past the sync point frame field-by-field using the step 
wheel on the tape deck. You will see either two or three 
keypunched fields. If the footage is not keypunched, look for two 
or three fields with little or no motion.

3. If there are two keypunched fields, the pulldown is either A or C. 
Step through the fields again and note where the timecode 
changes:

- If the timecode does not change from the first to the second 
fields, the fields came from an A frame.
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- If the timecode changes from the first to the second fields, the 
fields came from a C frame.

The following illustration shows a keypunch on the A frame. 
Notice where the timecode changes.

4. If there are three keypunched fields, or fields without motion, the 
pulldown is either B or D. Step through the fields again and note 
where the timecode changes:

- If the timecode changes from the second to the third fields, the 
fields came from a B frame.

- If the timecode changes from the first to the second fields, the 
fields came from a D frame.

5. Enter or edit the information in the Pullin column in the 
appropriate bin, as described in the next section.
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Modifying the Pulldown Phase Before Digitizing

After you determine the correct pulldown phase (as described in the 
previous section) you can modify the pulldown phase before 
digitizing in one of the following ways.

To modify the pulldown phase directly in the Pullin column:

1. Enter Text view.

2. Click the cell you want to modify.

3. Click the cell again. The pointer changes to an I-beam.

4. Type the pulldown phase and press Enter (Windows) or Return 
(Macintosh).

To modify the pulldown phase for multiple clips:

1. Ctrl+click (Windows) or Shift+click (Macintosh) the clips you 
want to modify.

2. Choose Modify from the Special menu.

3. Choose Pull-in from the Modify Options pop-up menu.

4. Select A, B, C, or D.

5. Click OK.

The pullin for all selected clips is changed, based on the pulldown 
phase you selected.

To modify the pulldown phase for multiple clips that have the same 
pulldown-to-timecode relationship:

1. Ctrl+click (Windows) or Shift+click (Macintosh) the clips you 
want to modify.

2. Choose Modify Pulldown Phase from the Special menu.

The Modify Pulldown Phase dialog box appears.
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3. Choose the correct pulldown phase for timecodes ending in 0 or 5 
from the pop-up menu.

4. Click OK.

The pulldown phase for each selected clip is changed, based on 
the pulldown phase you selected for 00:00:00:00. 

The Pulldown Phase setting also appears in the Film Setting 
dialog box (24p projects only). You can override that setting with 
the Modify Pulldown Phase dialog box. The selection in the Film 
Setting dialog box remains the same. For more information, see 
“Setting the Pulldown Phase” on page 189.

n After you digitize an NTSC transfer, the timecode shows a loss of every fifth 
frame of video. For example, don’t be alarmed if you find that your timecode 
jumps at one point from 1:00:14:15 to 1:00:14:17. You haven’t lost a frame, 
just an extra pulldown field.

Entering Frames-per-Second Rates for PAL Transfers

When you log in advance for PAL film-to-tape transfers, you must log 
the footage as clips that have a 25-fps play rate, as listed in the FPS 
column of the bin. If you want, you can digitize the footage on-the-fly, 
without logging the clips first. The minimum information required to 
capture the footage is the data logged in the Start and End video 
timecode columns.
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Entering Key Numbers

To add key numbers:

t Highlight the KN Start column, then type the key number for the 
sync point at the start of the clip using one of the following 
formats:

t Keykode™ Format: Type a 2-character manufacturer and 
film-type code, a 6-digit prefix for identifying the film roll, a 
4-digit footage count, a 2-digit frame offset, and then press 
Enter (Windows) or Return (Macintosh). 

The Avid system adds a space, hyphen, and either a plus sign 
(for 35mm projects) or an ampersand (for 16mm projects) to 
format the number. For example, in a 35mm project, to enter 
KJ 23 6892-1234+15, type KJ236892123415. In a 16mm 
project, typing the same number results in the code KJ 23 
6892-1234&15.

t Other Formats: Enter other key-number formats in the Ink 
Number column. Type up to eight characters for the prefix, up 
to five characters for the footage count, two digits as the frame 
count, and then press Enter (Windows) or Return (Macintosh). 

The Avid system automatically calculates the ending key number 
(KN End), based on the timecode duration.

c Make sure the correct number appears when you press Enter 
(Windows) or Return (Macintosh). For key-number formats other 
than Keykode, you might need to type the space, hyphen (-), and 
plus sign (+) or ampersand (&) to format the number correctly.



201

Logging Film Information

Entering Additional Timecodes (Optional)

Consider the following when you enter additional timecodes:

• In one of the Auxiliary TC columns (that is, Auxiliary TC1 through 
Auxiliary TC5) type an auxiliary timecode that syncs with the 
video timecode logged in the Start column. You can enter up to 
five auxiliary timecodes. Supported timecodes depend on your 
project: 30-fps for NTSC (drop-frame or non-drop-frame) and 
25-fps for PAL. Use one of the following formats:

t Enter a 2-digit format for hours, minutes, seconds, and frames. 
You need not enter a leading zero. (For example, to enter 
01:23:02:00, type 1230200.)

t When working with drop-frame timecode in the NTSC format 
(not applicable to PAL), enter a semicolon to indicate 
drop-frame timecode. (For example, to enter 01;23;02;00, type 
01;230200.)

• In the Sound TC column, enter the Nagra or DAT timecode for the 
original audio for the start of the clip. The timecode should sync 
with the video timecode logged in the Start column in the bin. 
Enter the source sound-roll identifier in the Soundroll column. 
Supported timecodes depend on your project: 30-fps for NTSC 
(drop-frame or non-drop-frame) and 25-fps for PAL. The clip 
being digitized must contain an audio track.

n Enter the soundroll value before you enter the timecode.

• In the Film TC column, enter timecode generated by a film camera 
(using Aaton or Arri timecode) for tracking the picture at the start 
of the clip. The film timecode should sync with the video timecode 
logged in the Start column. Only 24-fps timecode is supported. 
The clip being digitized must contain a video track.

• In the TC 24 column, enter timecode for original HDTV sources 
(1080p/24) or audio DATs created for PAL feature-film 
productions that use in-camera timecode.
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n You can use the Duplicate command to convert timecodes from one format to 
another. For more information, see “Duplicating a Column” on page 142.

Entering the Ink Number (Optional)

To enter ink numbers:

1. Open the Film Setting dialog box by double-clicking Film in the 
Settings scroll list of the Project window.

2. Make sure the correct options are selected for ink number format 
and ink number display, and click OK.

n You can log different ink number formats in the same project as long as you 
change the ink number setting to the appropriate format before you log each 
type. Changing the ink number setting affects only the next ink numbers you 
log, not numbers already logged.

3. Return to the bin and enter numbers under the Ink Number 
heading.

For example, use Keykode format or use a 2-digit prefix to identify 
the roll, a hyphen, a 4- or 5-digit footage count, a plus sign, and a 
2-digit frame count (for example, AA-00924+00).

Entering Additional Film Data

You can continue to log additional film data into the Labroll, Camroll, 
Soundroll, Scene, and Take columns, or into your own custom 
columns, as necessary. You can include the information in these 
columns on the cut lists you create for your edited sequence.
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Import settings
access and brief description of 63

Importing logs 110
Info display in the Project window

defined 71
Ink numbers

entering 202
Installing MediaLog 30, 31
Interface settings

changing text font and size 71

J
Joining cables 26

K
Key numbers

entering 200
formats for 200

Keyboard settings 73
access and brief description of 63

Keykode format 200
Keyscope log format 170
Kits for connecting hardware 26

L
Labroll data 202
Launching (Starting) MediaLog 34
Lock Bin Selection command (Special menu) 

138
Locking and unlocking

bin items 138
Log files

importing from film-to-tape transfer 
systems 124

Log Producer

importing 111
log format 170

Log Right
importing 110
log format 170

Logging
basic steps 23
defined 80
directly to bin from source tape 100
film information 192
information from active tracks 97
on-the-fly 104
pausing deck while 105
preparing for 94
without a tape 106
without deck connected 106

Logging tool 94
Logs

importing into MediaLog bins 111

M
Managing

bins 59
folders 59

Marking tape location
using Mark Memory button 103

Master clips
copying 128
duplicating 127
locking 138
moving 128
selecting 127
sifting 132

Matchback
options 40, 185

Media Composer application
quitting 45

MediaLog
importing logs into 111
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overview 19
Memory marks

adding 103
Menu commands

Align to Grid (Bin menu) 140
Custom Sift (Bin menu) 132
Delete (Edit menu)

columns using 142
Duplicate (Edit menu) 127
Headings (Bin menu) 140
Lock Bin Selection (Special menu) 138
New Bin (File menu) 54
Open Bin (File menu) 56
Page Setup (File menu) 164
Print Bin (File menu) 164
Set Bin Display (Bin menu) 119
Set Font (Edit menu) 72

Modify Pulldown Phase dialog box 198
Modifying

clip information 108
Moving

bin columns 140
clips 128

Multilevel sorting of columns 154

N
Naming tapes 95
National Television Standards Committee 

(NTSC) video editing format 40, 184
Nesting

projects in folders 42
New Bin command (File menu) 54
New User button (Select User and Project dialog 

box) 36
Non-drop-frame timecode

described 92
NTSC (National Television Standards 

Committee) video editing format 40, 184

O
Offline logging 106
Online Help See Help system
Open Bin command (File menu) 56
Open dialog box 56
Opening

a project 43
bins 55
Help 47
the Project window 51

OSC/R log format 170
Output timecodes

displaying in bins 155

P
Page Setup command (File menu) 164
PAL (Phase Alternating Line) video

frames-per-second rates 199
PAL (Phase Alternating Line) video editing 

format 40, 184
Phase Alternating Line (PAL) video editing 

format 40, 184
Picture Transfer Rate (Film Settings) 188
Preroll option (Deck Settings dialog box) 89
Print Bin command (File menu) 164
Printing bins 164
Project settings

defined 62
displaying 67

Project window
closing 51
displaying

bins 52
settings 62
usage 71

Info display
using 71

opening 51
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Projects
backing up 45
closing 44
creating new 39, 184
nesting in folders 42
opening 43
saving 45
selecting 39, 41
working with 35

Pulldown
finding at the sync point 194

Pulldown phase
modifying before digitizing 198
setting in Film Setting 189

Q
Quitting the Avid application 45

R
Removing

clips from bins 129
deck configuration elements 90

Renaming
bins 55

Replacing deck configuration elements 90
Restoring

default settings 69
Restricted characters

in project names 39, 184
in user names 36

S
Sample rate

setting 99
Save Bin command (File menu) 59

Saving
bins

automatically 59
manually 45

custom bin views 125
projects 45

Scene data 202
Select User and Project dialog box 35
Selecting

clips 127
projects 39
settings for deck configuration 82
tapes for digitizing 98

Serial (COM) Ports settings
access and brief description of 63

Serial Ports tool 76
Set Bin Display command (Bin menu) 119
Set Font command (Edit menu) 72
Setting up hardware

Macintosh 27
Windows 26

Settings
basic 64
bin 65
deck configuration 82
default

restoring 69
defining 64
described 62
film 65, 186
for film preferences 40, 186
keyboard 73
overview of 62
project

defined 62
displaying 67

scroll list 62
site

defined 62
using 70

tab 61
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user
defined 62

Settings scroll list
Audio Project 63
Bin 63
Deck Configuration 63
Deck Preferences 63
Film 63, 187
Import 63
Keyboard 63
Serial (COM) Ports 63
summary of contents 63
Workspace 63

Shot Lister
importing 110

Showing
bin columns 140

Shutting down the system
Macintosh 47
Windows 46

Sifting clips 132
Site settings

defined 62
using 70

Sorting
clips 153
columns

multilevel 154
Sound roll

entering data for 202
Source colors

assigning custom colors to 131
assigning in bins 130
limiting available colors of 131

Source tapes
selecting for digitizing 98

Specifications
Avid log 171

Standard headings
in Avid log files 174

Starting MediaLog 33, 34

Subclips
copying 128
duplicating 127
moving 128
selecting 127
sifting 132

Symphony application
quitting 45

Sync point
finding the pulldown at 194

T
Tape

naming schemes 95
Target bin

choosing 97
Telecine

importing log file from 124
Text editor

creating Avid logs with 172
Text tab (bin) 139
Text view (bin display)

defined 123
using 139 to 154

Three-perforation film projects 40
Timecode

display options
24p and 25p projects 155

entering 201
headings in Avid logs 175

Transferring
bins from another MediaLog system 115
bins to an Avid editing system 167

Trash
emptying 58
moving bins from 57
viewing contents of 57

Turning off equipment
Macintosh 47
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Windows 46
Turning on the hardware 29

U
Unique tape names 95
Unlocking and locking

bin items 138
Usage information

displaying 71
User

identifying 36
profiles 36
selecting another 68

User settings
defined 62
opening a project with 43
selecting a user from 68

Users
creating new 36
selecting existing 37
setting up 36

V
Video decks See Decks
View

bin
customizing 124
saving 125
types of 123

View Name dialog box (bin) 125
VITC (Vertical Interval Timecode)

in a bin 161
V-LAN/VLXi 84
VTRs See Deck

W
Word processor

creating Avid logs with 172
Workflow

film scene 118
Workspaces

assigning buttons to 73
assigning windows to 73
settings 63
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